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General Description

System 824 Overview

Congratulations! You now have your hands on the
smallest, most powerful, smartest Real Time Analyzer
and Precision Sound Level Meter available. We at Lar-
son Davis thank you for your purchase of the System
824, and hope you receive many years of good service
from it. This Training Manual has been developed to
jump-start your initiation into the use of your new
instrument. Consider it a “getting started” guide as
you get to know your 824.

This manual is best used accompanied with the instru-
ment. You will be guided through a step by step tour of
the System 824. The appropriate keypad button will be
shown on the page. The resultant 824 display will then
be presented to verify that you have performed the
correct action.

For example: @
This is the SETUP button on the lower set of keys on

your 824. Pressing this button will present the SETUP
menu on the 824’s display:
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dit Settings i
SLHM&RTA S5O :-
*SLHM&RTA 55A

P Logging
F HiRange

You will likely find the user interface of the System 824
to be very intuitive. However, it is recommended that
you initially follow the steps shown in this manual
until you have full exposure to the nuances of the
instrument’s operating system. It should also be men-
tioned that for detailed explanations of the System
824’s functions, you should defer to the System 824
User Manual. The purpose of this manual is to help the
user navigate through the 824 interface and make mea-
surements immediately. You will find that it will also
be useful to refer to this guide when you are trying
something new with the 824.

Step 1 If you have not already done so, turn the 824
on by pressing the On/Off key: @

The instrument will go through a brief start up cycle,
where it flashes the 824 ID screen.

bSystem 529 Zm

Enter Compang MHame
Enter Hddress Line 1
Enter Addreszsz Line 2

Serial Humber: AE1Z3
Rew: B.616 Z2ZDec1997

It will then switch to the display that was established
before it was powered off in its previous session. The
On/Off key can also be used the check the battery
power, as well as verify the on/off status of the dis-
play’s backlight. Press the On/Off key again to view
the PWR screen: @

Battery life is expressed in a percentage (100% being
fully charged). If you are powering the 824 with an
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User Interface

external source (such as AC), the voltage value will be
shown on this screen.

PUR o
Source: EHT i
Battery: +
Externalil3. E'uI'

Backlight.: +DFF
Contrast: #

Hold FUR to turn off.

You can also toggle the screen’s backlight by pressing
the right arrow key B

PUR =]
Source: EHT i
EBatteru:l +

Externalil2. E'ul'

Backlight.:+ Dn
Contrast: #

Hold FUR to turn off.

The screen contrast can be adjusted by continuous
presses of @ or @ . Contrast is expressed as a num-
ber between 0 and 100. You will find a value between
64 and 70 to be optimal.

PUR =]
Source: EixT i
Battery: A7 +

External:12. 8V

Backlight.:+ Dn
Contrast: #

Hold FUR to turn off.

Step 2 Press @ to exit the PWR screen

There are quite a few places you can go from here. It's
worthwhile to discuss the 824 User interface, starting
with the instrument keypad. The three keys on the top

2/19/98
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of the keypad (nearest the LCD screen) are used when
a measurement setup has been established and you are
ready to begin making measurements. Following is a
brief description of each of these keys.

@D - This is the RUN/STOP key. It initiates or ends a
measurement.

@ - The PAUSE key suspends a measurement. Press-
ing the pause key again will allow the measurement to
continue.

@ - RESET is used to clear the current measurement
from the display. The screen will clear and a new mea-
surement can be acquired.

The five keys located at the lower most part of the key-
pad affect the way that data is gathered, viewed, and
reported. Following is a brief description of each.
Pressing the key once gets you into the associated
menu. Pressing the key again (within the menu),
brings you out of the menu.

® The VIEW key is used to choose which data type to
be displayed. The views available depend the mea-
surement setup that you have selected.

@ - The DATA key is used to access the data store and
recall functions of the 824.

@ - The SETUP key brings the user into the instrument
setup menu. From here, the user can select a pre-con-
figured measurement setup, create a new one, or edit
an existing setup.

@® - The TOOLS key is used to access the different sys-
tem settings of the 824 including setting the clock,
viewing the available memory, establishing 824 lock-
ing (security) system, and external communications.
824 calibration is also handled within this area.

© - The PRINT key is used to establish the setting
required to communicate with an external serial
printer. The user also selects the type of report that
they wish to print from within this menu.
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The arrow keys: @, , @, ®, provide a variety of
different navigation operations within the 824’s oper-
ating system. This includes maneuvering through
menus and displays. Typically, the up @ and down
@ arrows move the user up and down through
menus and through parameters within the display
screens. The left @ and right (® arrows move the
user from one related screen to the next, control cursor
movement, and moves the user in and out of menus.
The check key @ is used to select an option or choice
from an 824 menu. It is also used to access the various
Settings menus from within the measurement displays
(views).

2/19/98
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As mentioned, the SETUP @) key is used to establish
the 824 measurement setups and associated parame-
ters. Press the SETUP @.

*SLHM&RTA
P Logging
F HiRange

The setup names in the setup menu screen list will de-
pend on the configuration of your 824. Specifically, it
will depend on the options that you purchased, and the
setups that you or another user may have already cre-
ated and stored in the 824.

Simple Sound Analyzer (SSA)

Common to all 824’s is the SSA or Simple Sound Ana-
lyzer. This pre-configured setup places the 824 in a
mode that performs simultaneous Sound Level Meter
(SLM) and 1/3 octave band Real Time Analysis.

2/19/98
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Step1 Press @ until this SLM&RTA (SSA) is high-
lighted.

Step 2 Let’s select this setup now by pressing the
check key: . At this point, you may be con-
fronted with the Recall screen and a message
that suggests that you have not saved current
measurement data. If the following screen
appears, press the desired choice. In this
example, the choice “No” will be selected.

Seturp n

Recall
IDPata Hot Sawved.
Sawve?

EEE[Ho|[Cance [

Step 3 Press ® once to highlight “No” (or what-
ever choice you desire)

Setup n
Recall
DPata Hot Sawved.

Sawve’?

Fes|A[Cance L]
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The SLM&RTA (SSA) setup is now
active denoted by the SLM+RTA
title at the top of the screen. Notice
that the SLM characters are bolded.
This denotes that the current view
within this operating mode is the
Sound Level Meter. If the reverse sit-
uation is true (RTA characters
bolded), we will need to change the
current View for the sake of this
exercise.

Step 4 Now press the check key: @ to proceed with
the SLM&RTA (SSA) setup recall. If another
message appears noting that the Active ID
has change, press (® to highlight “No”. Then

press the check key: @ to proceed.

SLH+RTA o
SPL 51 ':éw 1aq.
——— A i0o-
a0-

LE'E:_ EO- .

aa:pa. @ 0 1

Step 5 Press the VIEW @ to access the View menu.

Step 6

Step 7

If SLM is not highlighted, press @

SLH+RTA o
SPL 51 ':élﬁ' 120
_——— A i00-
a0-

LE'E:_ EO- .

aa:pa. @ 0 1

until itis.

Press () to select the SLM view choice.

2/19/98
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Step 8 Let’s make a measurement by pressing the
RUN/STOP key: &.

If this is the first time that the 824 has been used, the
following screen will appear to let you know that the
built in clock should be set so that your measurements
will be time and date correlated. If the clock is already
set, or you wish to skip this for now, go to Step 22

ak

Harning
Time Hot Set?

Continue

Step 9 To set the time, press TOOLS (@ to access the
clock/timer set feature.

Calibration
ClocksTimexr

Memoiry
Lock

Step 10 Press @ to highlight “Clock/Timer”.

2-4 System 824 Training Manual 2/19/98



Step 11 Press (® to enter the “Clock/Timer” menu.

ClocksTimer |
Current Timei

L1528 52
Current Date

(12786797
Da Of Heek

Within this menu, you can change the Current Time,
Current Date, Day of Week, Timer Mode, Run Date,
Stop Date, Run Time 1, Stop Time 1, Run Time 2, and
Stop Time 2. For now, we will only worry about setting
the time, date, and day of the week.

Step 12 Press @ or @ to highlight “Current Time”.

Clock”Timexr |
Current Tine'i

C15 2208 252)

C1Z786-97)
Day OFf Heek

Step 13 Press B to enter the “Current Time” modifi-
cation field.

Clock/ Tiner |
W Conrirent Time |I|

E:‘E—E

hhimm:iss

Step 14 Here,use @ or P to highlight the number
you wish to change. Once highlighted, use
@ or @ to increment or decrement the
number. Continue this process until you have

2/19/98
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the desired “Current Time” entered. Press )
to enter the time.

Current Date
12786797

Clock/Timer | I
Current Timejf
{1520 52 i
i
Day OFf HWeek ||

Step 15 To change the “Current Date”, first press @
or @ to highlight the “Current Date” field.

ClockTimexr
Current Timed
{15122 86
Current Date
1278697

Step 16 Press ® to enter the “Current Date” modifi-
cation field.

ClocksTimexr
Current Date"|

(18697
mnsSdd A yy

Use @ or ® to highlight the number you want to
change. Once highlighted, use @ or ® to increment
or decrement the number. Continue this process until
you have the desired “Current Date” entered.

2-6
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Step 17 Press @ to enter the date.

ClocksTimexr

Current Tlmew
(15 :22 BE}I

Current Date
1278697
Da Of Heek

Step 18 To change the current “Day Of Week”, press
@ or @ to highlight the “Day Of Week”
field.

ClockTinexr |
(15123 239
Current Date
1278637
Day Of Heek

(5atl

Step 19 Press B to enter the “Day Of Week” modifi-
cation field.

Step 20 Use @ or @ to highlight the weekday you
want active. Then press @.

ClocksTimexr |
(1523 139
Current Datei

C1Z2-86-37)

Bt d = = ) hked bked

2/19/98
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Step 21 Press TOOLS @ to return exit the Tools menu
and return to where we were previously in
the View.

SLHM+RETH o

SPL 51 n?dtél 13-

—— — i 400-
BO-
LE--:t EO-

aa:ea. 6 10 1

Step 22 If the 824 is not currently running, press the
RUN/STOP key: ¢

After a moment of stabilization, the measurement will
commence. The jogging man animation at the top right
corner of the display verifies that the instrument is
indeed “running”. Other items on this screen include
the digital readout of the current sound pressure level;
the detector rate selection (Fast, Slow, Impulse); the fre-
quency weighting selection (A, C, Flat); a graphic dis-
play of the sound pressure level time history; the Leq
for the current measurement, and the total runtime
since the last measurement reset.

SLHM+ETH ¥
lo )

SPL  Slow,,.
43.6%m
a0-

Le .
5295 bl
Hl:858. 684

Within this screen, many useful functions can be
accessed using the arrow keys.

2-8
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In the SLM View, (on-screen param-
eter modification) can be performed
usingthe @, @, @, ® arrow
keys.

Step 23 Press (® once and Slow will be highlighted.

SLH+ ¥
SPL 1ag. .
1. 1%mw

Bo-

LEX saEm :
Gain +8 0

Step 24 Now press ® (or @ )and you will cycle
through the three detector rate options: Fast,
Slow, and Impulse.

SLH+ i
SPL 1ag.
1. 1%mw
Bo-

Le .
52, 7ugn o IHII
Gain +8

After you stop on a desired detector rate option, you
either press the check key @ to exit the cycle mode, or
press @ to jump to the next screen controlled parame-
ter.

Step 25 Press @ for this exercise to get to the fre-
guency-weighting field.

SLHM+ETH i
SFL Fa

55 . 0o

B0O- .
Le .
53, 3deA 53““ h “I
Gain +8

Step 26 Press ® (or @) to cycle through the
weighting options (A, C or Flat). Again, press
the check key @ to exit the cycle mode, or
press @ to jump to the next screen con-
trolled parameter. You can also perform this
same kind of on-screen editing for the Leq
field. Here, you can toggle between Leq, SEL,
Min, Max, and Peak.

2/19/98
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The field at the bottom of the screen shows the total
duration of the current measurement. This field can
also be used for adjusting the signal gain of the 824.
Press the down arrow @ to highlight the gain field.
The following gain values can be established by press-
ing ® (or @ ):0, 10, 20, 30, 40, and 50.

Step 27 All of these settings (plus a few more) can
also be accessed from within the Setup menu
of the 824. Press SETUP @) to access this
menu.

dit Settings ojj
SLHM&RTA SS5A -
*SLHME&RTA 55A
F Logging LOG
rF HiRange ISH

Step 28 The Edit Settings function is currently high-
lighted. Press the check key @ (or B ) to
enter Settings menu.

Title il
(S5LH & Rea l— |

SLHM
RTA #
Intervals >

Here we can access menus to change the “Title” that
appears in the printed reports; the SLM (Sound Level
Meter) parameters; the RTA (Real Time Analyzer)
parameters; the RTA Intervals; the Report settings; and
the 170 (input/Output) Controls. Let’s enter the SLM
Settings menu.
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Step 29 Press @ or @ highlight SLM.

Settings
Title "
{SLM & Real-T
SLH g

RTA w
Intervals .

Step 30 Now press @ (or ® ) to enter SLM Settings
menu.

Detector

EE[Du]I

Heighting
C A

Gain [ +@1

Here you can see the different parameters that can be
changed for the SLM functions of the 824. The parame-
ters that can be accessed and modified include the
Detector Rate, Weighting, Gain, Transducer (Con-
denser microphone, Electret microphone, and Direct),
and Peak Weighting (A, C, Flat). In this exercise, let’s
change the Peak Weighting to C.

Step 31 Press @ until Pk Weighting is highlighted.

Settings
Gain [ +3]
Transducer

CCondnsi1

2/19/98
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Step 32 Press P to enter the Pk Weighting menu.
You will be required to reset the current mea-
surement. Press ) to perform the reset.

JPR Heighting
A

Step 33 Press @ to highlight C. Then press the check
key @ to select and exit.

Step 34 You will now be returned to the Settings
menu. Notice that C is now the current choice
for Peak Weighting.

[ SLH 1
Gain [ +81
Transducexr

CCondnsr]

We will explore the other Settings menus later. Now
we will look at the different SLM measurement views.

Step 35 To exit the SLM Settings menu you can either
press the left key three times, or press SETUP.
For this exercise, press SETUP ). You will be
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returned to the SLM + RTA measurement dis-

play.
SLHM+ETAH
SFL Slow
Jp 10

—— — T 100
:[1B
I_E'q: EO-

aa:pa. @ 0

2/19/98
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Any Data

As mentioned earlier, the VIEW key @ is used to
choose the different types of data that can be viewed
using the current measurement setup that you have
selected. Press VIEW @.

Since we are currently in the SLM&RTA (SSA) setup,
the View options will reflect this selection.

Up to this point, we have been using the SLM view to
explore the different ways to see sound pressure level
data. Let’s now explore some of the other ways that we
can view SSA data.

Step1 Press @ once to highlight “Any Data”.

2/19/98
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In this display mode, you can see the
real power of the 824’s sound level
meter capabilities. In fact, you can
see 33 simultaneous values from the
parallel slow, fast, impulse detectors
with concurrently applied A, C, and
Flat frequency weighting filters.
You can also view the associated
SPL, Leq, SEL, Lmin, Lmax, Peak,
and Taktmaximal (German versions)
with the different detector and
weighting values.

Here you will see the current SPL
(Sound Pressure Level) data from the
Fast and Slow detectors. You will
also notice that the A, C, and Flat
frequency weighting is applied con-
currently to the data.

Now you are viewing the current
Leq and SEL data with the various
weighting values applied.

Step 2 Press ) to activate the “Any Data” viewing

mode. If the 824 is not running at this point,

do so by pressing the RUN/STOP &

Any Lewvel-3 §
SPL Faszt SPL Slow

4 _§dEF Lo . 3dEF
48 DdBC 45 _9dBC
44, _FdEA 41 _LdBR

The title at the top of the current screen should be
“Any Level”. This indicates that we are viewing the
live sound pressure level data from the 824.

Step3 Press ® (or @) to cycle through the differ-

ent view screens. Stop when you get to the

“Any Level a” screen.

Any Lewvel-3 §
SFL Fast SPL Slow

L4 _§dEF Lo . 3dEF
48 DdBC 45 _9dBC
44, _FdEA 41 _LdBR

Any Lewvel-hb §
Leg SEL

07 _GdEF 79 _8dEF
48 _AdBC VA e
41 _GdEA 63 . dBER

Step4 Press P to getto the “Any Level b”screen.

3-2
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These are the current Lmax values
from the Fast and Slow detectors
with the weighting values applied.

These are the current Lmin values
from the Fast and Slow detectors
with the weighting values applied.

You are now viewing the current
Peak data from the Peak detector
with the A, C, and Flat weighting
values applied. The display also
repeats the SPL data from the Fast
detector.

Step5 Press (® again to get to the “Any Level ¢”.

Any Lewvel-c X
Lmax Fast Lmax Slow
BHA_RdEF 75 _2dBEF
75 _BdEC 1 _1dBC
732 _BdBEA 68 _HdER

Step 6 Press (® again to get to the “Any Level d”

screen.
Any Lewvel-d ¥
Lmin Fast Lmin Slow
49 _ BdEF 03 _"MdBEF
45 _4dBC 45 _5dBeC
39 _8dER 48 _44ER

Step 7 Press (® again to get to the “Any Level e”

screen.
Any Lewvel-= ¥
SPL Fast FPeak
53 _#{dEF 89 _3dBEF
49 4SdBeC 89 _LgdeC
44 _#dBA g7 _1dBR

Step 8 Press (® again to return to the “Any Level

a”.
Any Lewvel-a ¥
SPL Fast SPL Slow
L4 _#{dBEF Lo . 4dBF
48 _2dBC 45 _9dEC
4 . JdBERA 41 _LdBEA

2/19/98
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Here we see the value, date, and time
associated with the Lmax from the
824’s slow detector.

Now we see the value, date, and time
associated with the Lmax from the
824’s fast detector.

Here we see the value, date, and time
associated with the Lmax from the
824’s impulse detector.

Here we see the value, date, and time
associated with the Lmin from the
824’s slow detector.

AnyAT imei.a g1
76. 2dpF SrEE o L0
Hifoul997 19106143
71, 1dBC
HiHowio97 18182137
8. 6d5h
HiHowi997 18182137

Hnl_-l.-"'TiMELb F §
1. gdpp LM ast
BlHowl1997 18:86: 38
¥o. B8dBC
B1Howl1997 17:52:013
T2.8dBA
B1How1997 18:82:37

AnyATi ME'LC- I i
83, gdpF e 0P

Bi1How1397 1286038
7. DdBEC

B1Ho1397 17258013
Ta. AdEBR

B1HoW133Y 18:8Z2:47

AnyAT iME'Ld 31 ¥
53, 7dpF 0 =0
Hilonw 1997 17153137
6. SdEC
Bifou 1997 18104145
48, A45h
H1How1997 16104145

Step9 Press @ to access the “Any/Time-a” screen.

Step 10 Press ® to access the "Any/Time-b” screen.

Step 11 Press [ to access the ”Any/Time-c” screen.

Step 12 Press [P to access the ”Any/Time-d” screen.

3-4
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Now we see the value, date, and time
associated with the Lmin from the
824’s fast detector.

This is the value, date, and time
associated with the Lmin from the
824’s impulse detector.

Here we see the value, date, and time
associated with the Peak data from
the 824’s Peak detector.

Step 13 Press (® to access the “Any/Time-e” screen.

AngyAT i“Ei.E o F i
a9 papr LMin Fast

B1Howl1937 1753408
35 . FoBEC
A1Ho 1997 135684158
J39. BdEA

B1Ho1997 1856835824

=

Step 14 Press [ to access the “Any/Time-f” screen.

AngyAT imei'-F‘ _ i
55. gagp LMin IMp
B1Houl997 17253237

47 . BdEC
B1Mou 1997 15:65:65

1
d8. 2d4BA
B1Ho1997Y 185684845

MR
il
m

1

=

Step 15 Press (® to access the “Any/Time-g” screen.

Any/Time-g i
Peak
84. 1dEF

EED%E%?Q? BZ:44:57
aémif199? B2:43: 34
H2Decl1997 BS:d43:34

Step 16 Press (® to return to the “Any/Time-a”
screen.

AnusT inei'a g1 ]
79, Fdpp raE =10

B1How]1 997 12281237
EC

27 .

Al1How1997Y 185681839
3. 9dBA

B1Ho 1997 135162118

WL
'S

1

=
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Here you will see the current SPL Step 17 Press @ to access the “Any Impl-a” screen.
(Sound Pressure Level) from the
Impulse detector of the 824 with
simultaneous A, C, and Flat weight- HEF'HL II::;l —a SPL Inm {
ing applied. The SPL data from the 59 _2dEF 67 ddEF
Fast detector is also repeated here. - -

4R gQdBC G4 _9dEC

42 _4dBAR 48 _§dBR

Now you will see the current Lmax Step 18 Press ® to advance to the “Any Impl-b”
(Maximum Sound Pressure Level) screen.
from the Impulse detector of the 824
with simultaneous A, C, and Flat A I 1t ;
o . ny Impl-
tne Past cetctor s ropated hre, | Lnax Fast  Lnax Inel
' B3 _2dEF g4 _9dEF

g2 _9deC g4 _3dBC
#BA.14EAR g2 _GdEA

Now you will see the current Lmin Step 19 Press ® to advance to the “Any Impl-c”
(Minimum Sound Pressure Level) screen.
from the Impulse detector of the 824
with simultaneous A, C, and Flat A I 1 %
iqhti i i ng Impl-c
' 45 _GdBF CA . 2dEF

43 _QdBC 45 _4dBC
35.14BA 39 _2dERA

These are all of the screen associated with the “Any
Data” viewing option. Press VIEW @ to return to the
View menu.

RTA Live, RTA Max, and RTA Leq

Let’s now explore some of the different ways that we
can look at RTA data from the 824. First, make sure that
you are in the View menu.
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The “SLM+RTA Live” screen is
now active as is noted at the top of
the display. Notice that RTA is now
in bold letters informing us that we
are viewing the fractional octave
band data from the 824.

In the SLM+RTA Live screen, notice
the graphical display of the 1/3
octave band data. You will also be
able to see the frequency of where the
cursor is currently located and the
dB level at that frequency.

Step1l Now press @ to highlight the “RTA Live”
viewing option.

Step 2 Press @) to accept this View choice.

SLM+RTAH Liwve QULDLE

2HEAH=

In this sample, we are looking at the 800 Hz band. You
can move the cursor to other 1/3 octave band frequen-
cies by pressing the left or right arrow keys. Press
® to move the cursor to the 1000 Hz. 1/3 octave band.

SLM+RTAH Liwve 0ULDSE

You can view the overall summation of frequencies by
sequentially pressing (® to the last visible frequency

2/19/98
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band.

SLM+RTH Liuve 15

Now press () to access additional RTA viewing
options.

SLMA-RTA i
Tabu lar

Settings

Step 3  First verify that the “Tabular” option is high-
lighted. Then press ). The display will now
show the 1/3 octave band data in tabular for-
mat rather than graphic.

SLM+RTH Liuve 15

E3EEHE 125688H=
78. 9B &6 . 9B
SHEEH= 1c88EH=
2. JdB &1.8dE
1880EH= 2B80EH=
&1. 3B =4d. 2dEB

W

Step 4 Pressing the left and right arrow keys ( @ or
® ) will scroll through all of the frequencies
and amplitudes. When you have finished,
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press () again to re-enter the SLM/RTA view-
ing options.

SLM-RTA ¥

Spectrumnl
|
Settings -

Step 5 With “Spectrum” highlighted, press @ to
switch the display back to the graphical for-
mat.

SLM+RTRH Liue i
42 l? 120

100
dBl: 8o

e380H=

Step 6 Press ) again to re-enter the SLM/RTA view-
ing options. Now press @ to highlight the
“Graph” options.

SLHARTA ik
Tabu laxr D||
h 2]

Settings ||

Step 7 Press @ to enter the “Adjust Graph” screen.

Adjust Graph ¥
Scale

Level
+ 254E

v =Exit
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Step 8 The Scale and Level of the displayed graphic
can be adjusted now. Pressing the right or left
arrows controls the Scale settings. You can
expand or magnify the display by pressing
the right arrow. The left arrow compresses the
display. Press B .

Adjust Graph iy
Scale
#1 4E

Lewel
+ OF4E

v =Exit.

Notice the expanded vertical scale. Pressing the up or
down arrow controls the level. This moves the mea-
surement up or down within the display. Press ® and
@ a few times to see the measurement move verti-
cally within the display. Using both the Scale and Level
adjustments lets you focus in on areas of interest in the
measurement.

Step 9 Press () twice to return to the SLM/RTA
viewing options.

SLM/RTA ik
Tabu lae 0]

G ra
el

Step 10 Now press @ to highlight the “Setting”
options. Then press @.

SLHARTA 15
Tabulaxr O
Graph ]
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Step 11 Now press ) to enter Setting.

Intervals

Step 12 Press @ to highlight the RTA settings
option.

Settings
{SLHM & Rea l—'%‘ I|

Intervals .

Step 13 Next, press @ (or [ ) to enter the RTA set-
tings menu.

Filters is used to conserve power. Here we can change the settings for the RTA Detector

Setting the filter t012.5 KHz is less  (Fast, Slow), the fractional octave Bandwidth (173, or

energy consuming than using 20 1/1), and upper Filters frequency (low pass 12.5 kHz

KHz or 20 kHz) can be modified here. Now let’s change the
Bandwidth from 1/3 octave to 1/1 octave.
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Step 14 Press @ until Bandwidth is highlighted.

Bandwidth
C1-31

. ool
CZ8.8KH=1]|

Step 15 Now press @ (or ® ) to enter the Bandwidth
menu

Step 16 P

!
CZ6 . aKH= 1]

Step 17 Then press @) to initiate the bandwidth

change.
RTHA .
CSlowl
[Filters
! CZB.8KH= 1
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Step 18 Press @ three times to exit the Settings
menu and back to View. You will now see the
1/1 octave band data in the graphical display.

53 . E ;E_ ...........
dBF g .
Fazt
SPL FLT :E ]

For purposes of this exercise, let’s change the display
back to 1/3 octave bands. We’ll repeat the process we
just completed.

Step 19 First press (). Next press ® to highlight
“Settings”, then press () again. Verify that
RTA is highlighted, then press ) once more.
Press @ to highlight “Bandwidth”. Once
more, press () to enter the “Bandwidth”
menu. Press @ to highlight “1/3”. Then
press @) to actuate the change back to 1/3
octave analysis. To get back to the View dis-
play, press @ three times. We should now
have 1/3 octave band data in the graphical
display.

SLM+RTAH Live ik
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The screen contains a graphic of the
Max spectrum. This is the spectrum
that occurred that contains the larg-
est amount of energy during the cur-
rent run time. (» and @ are used
to move the cursor to the various fre-
quency bands.

Here the screen shows a graphic of
the Leq spectrum. ® and @ once
again are used to move the cursor to
the different frequency bands of the
spectrum.

Notice the next two choices in the
View menu are “RTA Leq” and
“RTA Max”. We have just viewed
these displays. They can also be
accessed here from the View menu.

Step 20 Press @ to access the “SLM+RTA Max”
screen.

SLMHRTH Max i
5.2

dBF
Fazt F
Max FLT

Step 21 Press @ to access the “SLM+RTA Leq”
screen.

SLM+R TFI Leq: )

78.1

dBF
Fazt
Leg FLT
OO:57.50

We are finished with the Simple Sound Analyzer
(SSA). We have seen the data that we can view in this
mode, and have learned how to change the different
setup and display options. Before exploring the other
types of setups that you may have in your particular
824, lets explore the other common features with all
824’s.

Step 23 Press @ to exit back to the SLM+RTA screen.
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CHAPTER

Data e

The DATA key @ provides access to the data storage
and recall functions of the System 824. Data files are
stored in the 824’s internal memory. First, verify that
the 824 is still running (running figure in top right cor-
ner). If it is not, press RUN/STOP &).

Step 1 With the instrument stopped, press (b to
enter the Data Files menu.

Data Files ¥
Store Datall

If you have never stored data with the 824, it will
appear as above. If there is data currently stored in the
824’s memory, the Data Files screen will appear as it
does below.

Data Files u

SLHM&ERTA EEI’-‘I[E

Notice that the “Store Data” function is currently high-
lighted. It signifies that the 824 is now ready to store
data.

To store the data, press the @. If the 824 is running (as
it should be now), you will see the following warning

2/19/98 Data @ 4-1



message on the screen.

Data Files |}
WMarning
Stor Required?
Stop?

S [Cance ]

If the 824 is stopped, this message does not appear and
the data is immediately stored.

Step 2 Press ) tostop the 824 and store the current
data. The 824 will beep to signify that the data
storage has occurred, and return the display
to the previously active View screen.

SLM+RTAH Live L]
43 4 120

100
dBly Bo

18806H=

Step 3 To examine previously stored data, press
DATA ).

Data Filecs
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Step 4 Notice that the stored data record now
appears in the Data Files list. Press @ to
highlight the stored record.

Data Files u
Store Data "

SLM&RTA S5A0

Step 5 To see information on the stored measure-
ment, press B .

Data Files 1#1.
SLHERTRA S55ARA
5LM & Real-Time Analy

A10ec1997 14:32:53
to AE???ZEA0E B8:08: 08
213 bytes

This screen shows the date and time of the measure-
ment beginning and end. It also displays the measure-
ment type (SLM&RTA SSA), the measurement label,
and the size of the data file in bytes. If you have multi-
ple data files (indicated at top right corner of screen),
you can cycle through the Data Files info for each mea-
surement by pressing @ or @ .

Step 6 You can recall stored data by pressing @.

Data Files u

Within this menu, you can recall the data you previ-
ously selected. If you have multiple stored data files,
you can recall them using “Beginning”, “Ending”, or
“Find”.
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- “Beginning” is used to recall the 15 data record.
= “Ending” recalls the last data record.

= “Find” lets you enter the record number of the data
record to be recalled.

Step 7 To recall the previously selected record, use
@ or @ to highlight “Recall Data”.

Data Files u

Begining

End ing
Find
Purge All

Step 8 Press ) to recall the currently selected record.

The 824 will beep and the data record will be dis-
played.
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About

The TOOLS (@ key accesses system oriented opera-
tions for the 824. These include calibration; setting the
824 clock/timer; checking memory; establishing lock
parameters; power monitoring; and setting communi-
cations protocol. Press TOOLS @ to access the Tools
menu.

This screen provides information
about your 824 including the serial
number and firmware revisions (for
the SLM and everything else).

“About” should be the current highlighted Tool choice.
This area contains 824 system information.

Step 1 To see this information, press @ to view the
“About-a” screen.

About=a

€=» SvsTEM 824

Serial MHumber: AEEEE
Rew: B.52& Z25How1997
SLM: B.172 Z8Febl1997
£11896 | ARSOH=DALITS, IMC.

2/19/98
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This screen lists some user definable
titles that can be used to personalize
your 824. We will describe how to
edit these fields shortly.

The About-c screen lists the options
contained in your 824. It also lists
the total RAM (memory) in your
unit.

Step 2 Press P toadvance to the “About-b” screen.

About=b (lUser |

Enter Compand MHame
Enter Address Line 1
Enter Address Line 2
S5LM & Real-Time Analy

bSystem 529

Step 3 Press ® again to advance to the “About-c”

screen.

About-c |
Instrumentss

S50 OFFT

v ISH 0o AlD

 LOG O IHT

o EHU o UIE

o RTH oo EAM

Step4 P

ress (» to return to the “About-a”

About=a

4=» SvsTEM 524

Serial Humbers: HEEEE
Rew: B.52& 25How1997
SLM: @.172 Z8Febl1997
£11996 | ARSOH=DALIS, INC.

Step5 P

Calibration
ClocksTimexr

Memoiry
Lock

screen.

ress TOOLS @ to return to the Tools menu.
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Step 6 To change the user titles within “About”,
press ® to enter this editing area.

Inst Settin
Hame

{Enter
Hame

{Enter Addres
Hame

=

Compan

This screen contains fields for entering your company,
address, and a title. This allows you to “personalize”
your System 824. Let’s enter a name in this exercise.
The first name field should already be highlighted. If it
isn’t, press @ or @ to highlight the first “Name”
field.

Inst Settings

Hame
{Enter Compan

Hame
{Enter Addres
Hame

Step 7 Then press B to enter this area. The follow-
ing message will appear.

| Harning
Overall Reset

Hﬂequired!
Reset?

N EER[Cance ]
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Step 8 Select Yes to reset. The following Name field
will immediately appear.

Inst Settings o

Hame

|§gter Compan|#

Step9 F

To scroll rapidly through the charac- Now type in a name. For this exercise, let’s enter the

ter choices, hold the @ or @ keys  word “TEST”. To do this, use @ or @ to scroll

down. through the alphabet. When you arrive at the desired
character, press ® to move to the next letter location;
then press @ or @ for the next letter. Continue this
process until the name is complete. Note that the scroll
list contains upper and lower case letters, numbers,
punctuation, and a variety of useful symbols.

Inst Settings L
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Step 10 Press @ to enter this name.

[u]

Inst Settings

Hame
{Enter Addres
Hame

Step 11 The other name field can be edited in the
same fashion. Press @ to return to the Tools
menu.

Calibration

Step1 From within TOOLS, press @ to highlight
“Calibration”.
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This screen displays the date and
time of the last 824 system calibra-
tion and calibration check. We will
perform a calibration next.

Step 2 To view the calibration information, press @)
to enter the “Calibration” screen.

Calibration o
Chec
EESEPIQQ? Bo: 38 5?
Heaiured- 4B

Eha%%
SEEI':'J'EJ? (5ol 38 5?
f+=et2lBn.5

Step 3 Press TOOLS @ to return to the Tools menu.

Step 4 Next, let’s press ® to enter the “Calibration”
menu to check and change the calibration val-
ues.

Calibration

Calibrator S-MH

Step 5 To check the current calibration, confirm that
“Check” is highlighted in the Calibration
menu.

Calibration

Calibrator S5-H
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Next, connect a microphone calibrator to the 824’s
microphone. Then turn the calibrator on. (Note: the
calibrator dB output level should match the number
associated with “Cal Level” in the Calibration menu. If
it does not, skip to “Cal Level” now and change the
value to match your calibrator).

Step 6 Press (® to perform a calibration check.

Calibration gi|
heck

114,04 0.0
Wait

Step 7 The system will go through a calibration
check. Upon completion, press TOOLS @ to
return to the Calibration menu.

Calibration

Calibrator S/H

Step 8 To change the calibration press @ to high-
light “Change in the Calibration menu.

Calibration |

Check

Cal Level

{114.808)>
Calibrator 5-H

Step 9 Next, connect a microphone calibrator to the
824’s microphone. Press (® to perform a cali-
bration change. The following screen may

2/19/98
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appear alerting you that a reset of the current
measurement is required.

Calibration

rTWﬁeaiured J1.73

E%SE-EI':'J'.:J? 5t=H 38 5?
f=etZl@. 5

Step 10 Press () to perform the reset. The following
screen will next appear to remind you to turn
on your microphone calibrator.

u]

= lihwvad §on

ChiCalibrate

[HERCalibrator
CaActive?
| Yes|

Ca e o

Step 11 After turning on the calibrator, press @ to
answer “Yes”. The system will go through a
calibration change.

Calibration Ll
Change

114. 04 0.0
Stable

Step 12 If you are using a condenser microphone (and
you have the 824 Option 01 installed), you
will be asked if you’d like to “Calibrate the
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High Range?” of the 824. Press ) to answer

“Yes”.

Tra lihvyat 1w a0
[ Calibrate |

[Calibrate High
IRange™?
L EERNol

A B A Ars 1A irira rr =

In order to perform high range mea-
surements, the 824 reduces the
microphone polarization voltage by
20 dB. It will take about one minute
for this change (and stabilization) to
occur, so that the high range can be
calibrated.

= = o
Calibration *

Stabilizin
FPlease Hait

Cance L [

ock _S53tor S/H

[y

After stabilization, the high range will be calibrated.

Calibration X[
Change

92.1# -21.9
Mait

The Cal Level field should contain a Step 13 Press TOOLS @ to return to the Calibration

dB output level value that matches menu.
the true output of your microphone
calibrator.

Calibration =<

Check

Cal Level

{114.808)>
Calibrator 5-H

2/19/98 Tools @
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Modifying the Calibration Level

Step 1 To modify the calibration level, press d to
highlight “Cal Level”.

Calibration
Check I

Calibrator S-H

Step2 Press B to enter the Cal Level modification
field.

Calibration

Step 3 Here,use @ or ® to highlight the number
you wish to change. Once highlighted, use
@ or @ to increment or decrement the
number. Continue this process until you have
the desired “Cal Level” entered. Press @) to
enter the level.

Calibration o

Check
Change
Cal Level I

C114.0808>
Calibrator S5.H
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As you probably know, it is good
measurement practice to use the
same calibrator every time you per-
form a calibration check and/or
change to your 824. The “Calibrator
S/N” is used to enter the serial num-
ber of the calibrator that you have
designated as your “824 calibrator”.

Clock/Timer

Step 4 Press @ to exit the “Calibration” menu.

This screen shows the current time,
day of the week, and date. The “next
action” field at the bottom of the
screen denotes that the 824 timer is
set to go off at the listed time. (00:00
typically indicates that no timer is
set).

The 824 contains a quartz clock that is used for apply-
ing date and time information to measurements, and
for establishing automatic timer parameters (run/stop
dates and times) for unattended measurements.

Step 1 From within TOOLS, press @ to highlight
“Clock/Timer”.

Step 2 To view the clock information, press @) to
enter the “Time-a” screen.

Time—a

15:18:52

Sat B6Dec1997
Mext action: BE: B8

2/19/98
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Within this menu, you can change
the Current Time, Current Date,
Day of Week, Timer Mode, Run
Date, Stop Date, Run Time 1, Stop
Time 1, Run Time 2, and Stop Time
2. These parameters are all changed
in a similar way.

Step 3 Press P toadvance to the “Time-b” screen.

Time=hb o

Timer Mode: of
H1Janl1997 Lo 31Dec1999
From @3:88 to 17:i@8

Mext actions: EE: 88

This screen list the parameter associated with the 824
timer including “Timer Mode” (on/off), and the timer
start and stop dates/times.

Step 4 Press TOOLS @ to return to the Tools menu.

Step 5 To change the clock parameters, confirm that
“Clock/Timer” is highlighted in the Tools
menu.

Step6 P

15208 52
Current Date

Current Tlme'
{ 12,8697 i

Da Of Heek

The following is an example of performing a Clock/
Timer modification by editing the “Current Time”.
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Step 7 Press @ or @ to highlight “Current Time”.

ClocksTimer |
Current Timei

L1528 52
Current Date
(12786797
Da Of Heek

Step 8 Press B to enter the “Current Time” modifi-
cation field.

Clock Timexr
WICurrent Time |I|

(AR =21 =54

Step 9 Here,use @ or B to highlight the number
you wish to change. Once highlighted, use
@ or @ to increment or decrement the
number. Continue this process until you have
the desired “Current Time” entered. Press @)
to enter the time.

ClocksTimer |
Current Tinei

L1528 52
Current Date
(1278637
Da Of Heek

2/19/98
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Step 10 To change the “Current Date”, press @ or

@ to highlight the “Current Date” field.

ClockTimexr
Current Timel
{15122 186
Current Date
{12/°86-97)
Da Of Heek

ﬂ

cation field.

Clock:”Timexr
C{Current Date"|

(1 8697

mnsSddS Yy

Step 11 Press [ to enter the “Current Date” modifi-

Step 12 Use @ or B to highlight the number you

want to change. Once highlighted, use @ or
@ to increment or decrement the number.
Continue this process until you have the
desired “Current Date” entered. Press &) to

enter the date.

CClock s Timer
Current Time
{15122 86
Current Date

{1Z2-°86-97)
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Step 13 To change the current “Day Of Week”, press
@ or @ to highlight the “Day Of Week”
field.

ClocksTimexr
(15 :23 39 [P
Current Date ?

Step 14 Press [ to enter the “Day Of Week” modifi-
cation field.

Step 15 Use @ or @ to highlight the weekday you
want active. Then press @ .

CClocks Timer | .0
C15:23 39
Current Date
C1Z-86-97)
IDay Of Heek

(Sath

TIMER

From within the “Clock/Timer” menu, we can set and
activate a timer that causes the 824 to turn itself on and
gather data automatically.
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“Block Mode” is used when you
want to gather data for one single
measurement period that could span
seconds, minutes, or even days. (uses
Run Date, Stop Date, Run Time 1,
and Stop Time 1)

“1/Day” is used when you want to
collect data during a single daily
time period, for several sequential
days. (uses Run Date, Stop Date,
Run Time 1, and Stop Time 1)

“2/Day” is used when you want to
collect data during a two separate
daily time periods, for several
sequential days. (uses Run Date,
Stop Date, Run Time 1, Stop Time 1,
Run Time 2, and Stop Time 2)

Step 1 To modify the “Timer Mode”, press @ or
@ to highlight the “Timer Mode” field.

ClockTimexr
C1Z2-°86-97)>
Day OFf Heek
{Sat)

— =

Step 2 Press B to enter the “Timer Mode” modifi-

cation field.

Block

1-Dauy
2-Da

Step3 Use @ or @ to highlight the desired Timer

Mode selection.

5-16

System 824 Training Manual

2/19/98



Step 4 For exercise sake, choose “Block Mode” by
using @ or @ to highlight “Block™.

= mO
T imexr

¥EB lock

Z/Da

Step 5 Once you have selected the “Block™ Timer
Mode choice, press @ to activate it.

Clock/ Timer | -0
{1Z2/-806-97)
Day OFf Heak
{Sat)

e dd | = =} b ek

Step 6 To change the “Run Date”, first press @ or
@ to highlight the “Run Date” field.

CClock/Timer
{(S5at>
HMode
Elockl

Fun Date
(B1-7.81-97>

T imexr

Step 7 Press B to enter the “Run Date” modifica-
tion field.

Clock/Timer | >0
H

[ F-a1-97 |
TS S dd S uy I
L N N

2/19/98
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Step8 Use @ or P to highlight the number you
want to change. Once highlighted, use @ or
Q@ to increment or decrement the number.
Continue this process until you have the
desired “Run Date” entered.

ClocksTimexr
_ |Fun_ Date
T 1im
(127803797
= mnsdd A gy

=0

Step 9 Press () to enter the run date.

ClockTimexr

Timer Mode

{Sat)
CBlock]

Fun Date

{1Z2-86.97)

For sake of economy, use a short measurement dura-
tion in this exercise (one minute). To change the “Stop
Date”, first press @ or @ to highlight the “Stop

Date” field.

ClockTimexr

CEBlock]

Fun Date
12786797
Stopr Date

{12-31.-99)
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Step 10 Press [ to enter the “Stop Date” modifica-
tion field.

Clock/ Timer | o0

Sto Date

RunEra1s99) [
= e dd A yy ;

Step 11 Use @ or B to highlight the number you
want to change. Once highlighted, use @ or
@ to increment or decrement the number.
Continue this process until you have the
desired “Stop Date” entered. For this exercise,
use the same date as the “Run Date”.

Clock/Timer | o0

Sto Date

Runizres o0
| s dd oy

e dd | = =} b ek

Step 12 Press @ to enter the “Stop Date”.

M lock/ Timexr | 20

CElock1
Run Date
{1Z2/86-97) 1
Stop Date

e et | = = el eked

C1Z2-786-97)

2/19/98
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Step 13 To change the “Run Time 17, press @ or ®
to highlight the “Run Time 1” field.

ClockTimexr
C1Z-°86-97)>

Stop Date
12,8697

Funn Time 1
{88 88>

Step 14 Press P to enter the “Run Time 1” modifica-
tion field.

Step 15 Use @ or B to highlight the number you
want to change. Once highlighted, use @ or
Q@ to increment or decrement the number.
Continue this process until you have the
desired “Run Time 1” entered.

=0

ClockTimexr

LT s s

Step 16 Press ) to enter the “Run Time 1”.

ClockTimexr
(12786797

Stor Date
12786797 }

Fun Tlne i ]

(15 :58)

2/19/98
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Step 17 To change the “Stop Time 17, press @ or @
to highlight the “Stop Time 1” field.

ClocksTimexr
(1278697

Fun Time 1
15 5@

Stop Time 1 32
(17 @887 i

Step 18 Press [ to enter the “Stop Time 1” modifica-
tion field.

Clock/Timer | o0

Stop Tine 1

FI7H T

hh tmm

Ru

e bdd | == ) b ek

Use @ or B to highlight the number you want to
change. Once highlighted, use @ or @ to increment
or decrement the number. Continue this process until
you have the desired “Stop Time 1” entered.

Step 19 For this example, choose a “Stop Time 1” one
minute later than the “Run Time 1”.

Clocks Timer | &
Stop Time 1

EISH=E1
hh Zrmm

e et | == bt ek
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Step 20 Press @) to enter “Stop Time 1”.

Clocks Liner | "4
C1Z-°86-97)>
Funn Time 1
{15:58)>
Stop Timne 1
(15:81>

—

Run Time 2 and Stop Time 2 are changed in the same
manner as Run Time 1 and Run Time 2. These are only
used when the 2/Day timer mode is desired.

The “Block” Timer is now set. The 824 will turn on and
gather data (using the active measurement setup) until
the stop date/time are reached.

Press @ to return to the “Tools” menu.

Memory

Step1 While in the TOOLS menu, press @ to high-
light “Memory”.
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The “Memory-a” screen displays the Step 2 Press @ to enter the “Memory-a” screen.
amount of available memory in your
824.

Hemory=—a [ |

Free 99.c8X
213z82  of  ayaa bygtes

=5H
Lag: 10
Shap: Cal: o

“Memory-b” provides additional Step 3 Press (® to advance to the “Memory-b”
memory information including the screen.

number of data files stored and the
available setup allocations.

Hemory=hb [ |

Free 99.68X
213282 of ayaa bytes

Data Files: =
Setups Allocated: 1A
Total Memorg: 2eZld4d

Step 4 Press TOOLS @ to return to the Tools menu.

Within this menu you can purge Step5 Press (B toenter the Memory menu.
data files, allocate the number of
EEPROM registers for storing set-
ups (default 10), and store measure-
ment setups to an EEPROM within
the 824.

Unless you have valuable data stored in the 824, go
ahead and purge the files you stored to memory ear-
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lier. Press ® to initiate this process.

Mommnwvas u

Purge

Step 6 Press @ to purge all of the 824 data files. Press
TOOLS @ to return to the Tools menu.

Lock

Step1 From the TOOLS menu, press @ to high-
light “Lock”.

1]
1}
ClocksTimexr (1|
Memoxr &

The “Lock™ screen shows the lock  Step2 P

ress (¥) to enter the “Lock” screen.
status of the 824.

Locls o

Mot Locked
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Press TOOLS @ to return to the Tools menu.

Power Monitor

Step1 While in the TOOLS menu, press @ to high-
light “Power Monitor”.

Tools o
Calibration O
C locksTimer gl

Memory
Lock

Power Monito

The “Battery” screen provides infor-  Step 2  Press ) to enter the “Battery” screen.
mation regarding the power source
of the 824. Battery life is expressed

in a percentage (100% being fully Eﬁﬁgg"g EHT 1D5
charged). If you are powering the Battery +
824 with an external source (such as External 113, Eu 10
AC), the voltage value will be shown Battery: _1.80U

on this screen. MiMH -5°F §

Within the “Power” menu you can Step 3 Press @ to enter the “Power” menu.
control the Power Settings, and
Charge Mode for the rechargeable
NiMH batteries. You can also access
the “Battery” screen by selecting
“Status”.
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Within this menu, you can control
the Power Settings parameters.
These include “Power Off Mode”,
“Auto-Off Time”, “Standby Time”,

Step 4 With “Status” highlighted, press B to verify
that this is an alternative route to the “Bat-

tery” screen.

Battery
Sources EHT
Battery:
Externalil3. E'ul'
Battery: 1.@6EL)

] E°F
HiMH #

Step 5 Press @) to return to the “Power” menu.

Step 6 Let’s take a look at the various “Settings”
options. Now press @ to highlight “Set-

tings”.

Step 7 Press@ (or ® )toenter the “Settings” menu.

“Backlight  Time”, “Backlight”,

“LCD contrast”, and “External

Power”.
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Step 8 To look at the “Power Off Mode” press @ or
@ to highlight this choice.

Power OFff Modeij
Cauto OfF |
auto—0ff Time
12>

Standby Time

The “Blank LCD” selection will Step 9 Now press @ (or B ) to enter the “Power Off
cause the LCD screen to turn off, Mode” menu.

while still allowing the 824 to con-
tinue gathering data. The idle time
required before this happens is set in "‘ﬁ
the “Auto-Off Time” feature that we BElank LCD
will look at shortly. “Auto Off” =

enables a mode that causes the 824 to Manual D'F*: —
automatically power off if it is idle HlEtandhg T ime
for a predetermined time (this time is
also set in the “Auto-Off Time” fea-
ture). This is a power saving feature Select a choice, or press @ to return to the Power Set-
of the 824. “Manual Off” overrides tings menu.

“Auto Off” so that the 824 will only
power off if the user presses the On/
Off @ key.

[u]

Power OFff HModeij
Caouto OfF i |
auto—0ff Time

12>
Standby Time

Step 10 Let’s press @ to highlight “Auto-Off Time”.

Fower

Aauto—0Off Time

12
Standby Time
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Step 11 Press @ (or B ) to enter the “Auto-Off Time”
menu.

Here you can establish the duration of idle time
required before the 824 automatically powers off
(when “Auto Off” is enabled). The @ and @ arrow
keys increment through the minute numbers, while
@ and P toggles between to minute fields.

Step 12 Once you have established a desired “Auto-
Off Time, press @.

Fouwer
Powexr Off Hode|]
Cauto OFF (L
Auto—0Off Time

Step 13 Now press @ to highlight “Standby Time”.

| Fower ﬁ

CAuto OFfF ]I
Auto—0Off Time

c12:i
85
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“Standby Time” places the 824 in an Step 14 Press @ (or B ) to enter the “Standby Time”
energy conservation state by turning menu.

off the LCD (screen), the serial port,
and the DC output, while still gath-
ering data. Here you establish the
“Standby Time” before the 824 auto-
matically powers these features
(LCD, serial port, and DC output)
off.

Step 15 In order to have the LCD turn off, you must
select “Blank LCD” in the “Power Off Mode”
menu that was shown above. The @ and @
arrow keys increment through the minute
numbers, while @ and (® toggles between
to minute fields. Once you have established a
desired “Standby Time, press ).

Fower 1
CAuto OfF i | I
uto—0ff Time i

12>
Standby Time
. (B3>

{
Backlight Time
38>
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Within the “Backlight Time” screen Step 17 Next, press @ (or B ) to enter the “Backlight
you can determine the amount of idle Time” menu.

time that the 824 backlight stays on
before it automatically turns off. It
should be noted that the backlight o
draws a significant amount of cur- Backlight Time
rent and will greatly reduce the Q|
amount of time that you can operate sec
on batteries.

The @ and @ arrow keys increment through the
minute numbers, while @ and B toggles between to
minute fields.

Step 18 Once you have established a desired “Back-
light Time, press ).

Fouwer 1
(12>

Standby Time |
{84
Backlight Time

Step 19 Now press @ to highlight “Backlight”.
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The “Backlight” screen provides
another means of enabling or dis-
abling the backlight function.

The “LCD contrast” window lets
you adjust the screen contrast of the
display. The @ and @ arrow keys
increment through the contrast
numbers, while @ and [ toggles
between the contrast fields. Contrast
is expressed as a number between 0
and 100. You will find that a value
between 64 and 70 to be optimal.

Step 20 Then press @ (or ® ) to enter the “Backlight”
menu.

Backlight

¥ 0On |I| i

~ 2D
Backlight

Step 21 Use @ or @ to establish your backlight
choice. Press (@) to activate this selection.

Fower 1
(B4
Backlight Time

Backlight

Step 22 Now press @ to highlight “LCD Contrast”.

Step 23 Then press @ (or ® ) to enter the “LCD Con-
trast” menu.

Fower

L ki kT

Lecd Contrast

Ea
Lou ol ds b

(E@)>
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Here you can choose your preferred
means to power the 824, should you
wish to use an external power
source. The choices here are “AC
Pwr”, or “Battery”. “AC Pwr” is
used if you plan to power the 824
from an AC source using the 12-Volt
adapter that was provided with the
instrument when it was purchased.
Note that this configuration will also
charge the NiMH batteries if they
are in the 824 battery compartment.
NOTE: You should never attempt to
use the 12-Volt adapter with alkaline
batteries installed in the 824. This
could cause the batteries to overheat
and leak, which may result in serious
damage to the 824.

Step 24 Once you have established a desired “LCD
Contrast”, press @.

Lcd Contrast H
(60> N

Step 25 Press @ to highlight “External Power”.

FPower 1
CL Onl
Led Contrast
{502
External Puuer'
CAC Pur :||I|

Step 26 Next, press @ (or [® ) to enter the “External
Power” menu.

= o
External Fower
Battery

External Puuer'
CAC Puwuxr 1

Choosing “Battery” is the proper choice if you plan to
power the 824 from an external 12-Volt battery (lead
acid for example). Please consult Larson Davis regard-
ing the proper method of connecting the 824 to the
external battery.
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Here you can choose the method of
recharging the internal NiMH bat-
teries of the 824. The choices are: Off,
Trickle, Pulse, or Full. Trickle pro-
vides a slow charge to the batteries,
which will ultimately prolong the life
of the NiMH cells. Pulse offers’ Full
is the quickest method of recharging
the batteries, but will reduce the
number of times that the NiMH can
be charged.

Step 27 Use @ or @ to establish your external bat-
tery choice. Press ) to enable this selection.

Fower 1
C Onl
Led Contrast
5B
External Pnuer'
. CAC Pur :||l|

Step 28 Press @ to exit the “Power Settings” menu
and return to the “Power” Menu.

Step 29 Now let’s press @ to highlight “Charge
Mode”.

Charge Mnde O
CFull 3l

I T LT J.l_!ll[E

Step 30 Next, press @ (or B ) to enter the “Charge
Mode” menu.

Charge HMode
1mi K]
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Communication

Step 31 Use @ or @ to establish your battery

charge choice. Press @) to enable this selec-

tion.

O
CFull 5] (| 2=

Tor LFETIN'ELA BN & Lrik A lul.m

ClocksTimexr (13|

Calibration (1|
Memoiry El

Tools O

highlight “Communication”.

Fower Mownitord
Communication3:

Too ls O
ClocksTimexr (13|
Memoiry (13|
Lock O

Step1 From within the TOOLS menu, press ® to
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The screen becomes active during
serial communication with a com-
puter. You can monitor the commu-
nication process within this window.

Here, you can establish and modify
the parameters associated with com-
munication to an external device,
such as a computer or modem. The
options are Baud Rate, Serial
Address, and Flow Control.

Step 2 Press @ to enter the “Communication”
screen.

Communications O
Rcuds Ade:100 # O
03

Sent: -
" »«AAA+ > -

Standby Timer: 4

Step 3 Now, press () again to enter the “Serial Com-
munication” screen.

= o
Serial Comm.

Baud Rate Hi
C 958Ea1

Serial Address
{1008
Flow Control

Step4 Use @ or @ to highlight “Baud Rate”.
Press @ (or [ ) to enable this selection.

Your baud rate choices are: 300, 1200, 2400, 9600, 19200,
28800, 57600, and 115K.
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Here you can establish a serial
address for the 824 for situations
where you may have multiple devices
connected via the computer serial
port.

Step 5 Select your baud rate choice using @ or @ .
Press ) to enable this selection.

Serial Comm.

Flow Control

Step 6 Now press @ to highlight “Serial Address”.

Serial Comnm.
Baud Rate
L 958E1
Serial Hddressm

C18@E)
Flow Control

Step 7 Press@ (or ® )toenter the “Serial Address”
screen.

Serial Comnm.
= = = | |
]Eerial ﬁddr955|

1 &%)

]
Flow Control

Step 8 Usethe @ and @ arrow keys increment
through the address numbers, while @ and
® toggles between the three address fields.
Press @ when you have selected the desired
address.

" Serial Comm.
Baud Rate I
L 958371

Serial Address
L1806
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Within this menu, you can select the
method of handshaking appropriate
for the device which you plan to com-
municate with. The choices are:
“None”,  “Hdwr”  (hardware),
“Xoff”, and “Both”.

Step9 Now press @ to highlight “Flow Control”.

m]

Serial Comm.

Flow Control |
CHdwx 1|

Step 10 Press @ (or B ) to enter the “Flow Control”
menu.

Flow Control
Hone

XOfr¥
Both

Step 11 Choose your Flow Control selection using
@ or @ . Press ) to enable this choice.

Serial Comm.

Flow Control
CHdwx 1|

Step 12 Press @ to return to the TOOLS menu. Press
@ one more time to exit.
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CHAPTER

Log - Logging Sound Level
Meter (Option 01)

Your 824 does not necessarily contain the Log option.
This is a non-standard option that is purchased sepa-
rately from the basic Model 824. If you indeed have
purchased this option, proceed.

Step 1 To enable the logging analysis option, first
press SETUP @.

*SLM&RTHA
r Logging
F HiRange

Step 3 Press @ (or B ) to select this Setup option.

SLH o
SPL Slow go. ;
dB

——— O E
4o-
LEu;‘: a0-

dER
BE: 0E, BE
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Current SLM

Step 4 Next, press VIEW @ to access the different
measurement viewing choices for the Log
option.

We have already seen and used the “SLM” and “Any
Data” View modes from the standard SSA setup. Let’s
now look at the “Current SLM” View.

In this display, you will see a graphic
time history of the measured sound
pressure, along with a “real-time”
digital numeric readout of the sound
pressure level. The associated setup
parameters  (detector rate and
weighting), and run time are also
shown. It should be noted that “Cur-
rent” means the data since the last
RESET ©.

Step1l Press @ to highlight the Current SLM selec-
tion.

Exposuire O

Step 2 Press ) to accept this View choice. The “SLM
Current-a” screen is now active as is noted at
the top of the display.

ISLH Current—a i

64.8%85
Ml

B0-

Slow SPL BO-
@A 37,03 1

If the 824 is not currently running, press RUN/STOP

® to start a measurement.
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The screen lists the date and time
when the current measurement
began, along with the current date
and time if the measurement is run-
ning (stop date and time if it is not
running), and the elapsed run time.

The “SLM Current-c” screen lists
the Lmax and Lmin values, and the
date and time when they occurred for
the current measurement.

The “SLM Current-d” screen lists
the A, C, and Flat weighted Peak
values along with the date and time
when they occurred for the current
measurement.

Step 3 The current data can be witnessed by per-
forming a data reset. Press RESET @.

ISLHM Current—a X

dEiEﬂ'

5? n E A 100 .
Bu. .

Slow SPL EO- .

aa:@l. @@ 0 nl

Notice that the run time clock is set to 00:00:00 and
restarts when the reset is performed.

Step4 Now press B to see the “SLM Current-b”
screen.

ISLHM Current—-h X

Began
BZ20ecl1997 @9:
to BZDecl1997 A9:

Elapzsed Eun Ti et

88:88. 08

Step5 Press B to see the “SLM Current-c” screen.

ISLHM Current—c ¥
Maximum: 60.3 dBA
AZ0ecl1997 B9:25:17

Minimums: 43. 6 dBA
AZDec1997 A9:25:09

Step 6 Press (B to see the “SLM Current-d” screen.

ISLHM Current—d ],2
eda

87 . BdEF

B20ec1997 BI:25024
835. 9dEC

B20ec 1997 B9:25031

w i
B20ec1997 89123845
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Here we see the Leq and SEL values,
with the total run time for the cur-
rent measurement.

Modifying the SLM Settings

Step 7 Press B to see the “SLM Current-e” screen.

ISLH Current—e §
TWA Lex 6H.Y dEA
e SEL. 83.0 dEA

B:AZi52.59

Step 8 Press P to return to the “SLM Current-a”
screen.

ISLH Current-a X

57.6%

Slow SPL BO- .
aE:al. e 0 .I

This section applies to both the current and overall
SLM of the 824, since you cannot have independent
settings for each. To change the settings for the SLM,
you can either go to the SETUP menu by pressing @),
or you can take a shortcut from where you are now.
For this exercise, use the shortcut.

Step 1 From within the “SLM Current” window,
press @.

You are now viewing the SLM setting screen. From
here, you can modify the various parameters associ-
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ated with the 824 Sound Level Meter functions. The
“Graph” settings operate the same as was shown ear-
lier in the Simple Sound Analyzer (SSA) section.

Step 2 For review, first verify that “Graph” is high-

lighted.

Step 3 Now press @ to activate the “Adjust Graph”

feature.

Adijust Graph

Scale B
21 70-
Level :ﬂﬁ
3 20dE -
v =Exit

i

Step 4 The Scale and Level of the SLM time history
graphic can be adjusted now. Pressing @
and [ controls the Scale settings. You can
expand or magnify the display by pressing
® . The left arrow @ compresses the dis-

Step 5

play. Press ®

Adjust Graph

Scale 53
1./ 50

yg-
Level YE-
+ JB<E Yy
v =Exit. iz

i

Notice the expanded vertical scale. Pressing
the using @ or @ controls the level. This

moves the measurement up or down within
the display. Press @ and @ a few times to

Log - Logging Sound Level Meter (Option 01)

6-5



see the measurement move vertically within
the display. Using both the Scale and Level
adjustments lets you focus in on areas of
interest in the measurement. Press @) to
return to the SLM Current-a screen.

$SLH Current—za ]
47.2% '
" y

Slow SPL
A5:d5.43

Step 6 Press () to return to the “SLM Settings” win-
dow.

Step 7 Now press @ to highlight “Settings”.

[SLH Settings f

Step 8 Press the check key ) to enter Settings menu.

SLH 1
Detector
[Eluu]l

Heighting
C a1l

Range
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The parameters that can be modified Step9 Press @ or @ to view the different parame-

here include: SLM Detector (Fast, ters that can be changed for the current SLM
Slow), SLM Weighting (A,C, Flat), setup. For this exercise, press @ until Pk
Range (Normal, Low, High), Trans- Weighting is highlighted.

ducer (Condenser microphone, Elec-
tret microphone, and Direct), and
Peak Weighting (A, C, Flat),

LH i
CHormall
Transducer

CCondnsi]

Step 10 Press [ to display the Pk Weighting menu.
You will be required to reset the overall mea-
surement.

— -
| Harning
1Dverﬁll Rescet
FRequired?t
.IReset?

EEE[Cance 1]

Step 11 With “Yes” highlighted, press @ to perform
the reset.

Pk Heighting

A
L
#FLT

CELTIMm
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Step 12 Press @ to highlight C. Then press the check
key @ to select and exit.

[Pk _HMeighting

CELTIMm

Step 13 You will now be returned to the Settings
menu. Notice that C is now the current choice
for Peak Weighting.

SLH o

CHormall
Transducexr
CCondnsi]

Step 14 Press @ to return to the SLM Settings menu.

[SLH Settings f

We will look at the TWA settings when we cover the
Exposure features of the 824.

Step 15 Press @ to exit the SLM Settings menu.
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Stats

Displayed here are the current set-
tings of the SPL exceedance thresh-
olds, with the number of times that
these values have been surpassed
during the current measurement.

These are the current settings of the
Peak | and | exceedance thresholds,
with the number of times that these
limits have been surpassed during
the current measurement.

Here we see the number of time that
the instrument has been overloaded
during the current measurement.
Note that overloads are caused when
the signal exceeds the capacity of the
824’s analog to digital converters.
They commonly occur when the
microphone is bumped against a
hard surface. Overloads render a
measurement invalid.

Step1l Press @ to move to the SLM Stats screens.

Immediately shown is the “SLM Stats-a”

screen.
iISLH Stat=-a 15
SPL gxcesded
115dEA 1 times
SPL gxcesded
1z28dEBA B times

Step2 Press B toadvance to the “SLM Stats-b”
screen.

S5LH Stat=-b i

§
Feak-1 excesded
148dBF B times
IT exceeded
A times

Peak-
1484

Step 3 Press B to advance to the “SLM Stats-c”
screen.

§SLH Stats-c §

Mo Ouverloads

hawve occurred.

2/19/98 Log - Logging Sound Level Meter (Option 01)

6-9



Modifying the STAT Settings

Step4 Press B to return to the “SLM Stats-a”

screen.
1SLH Stat=-a ii
SPL gxcesded
1154dERA 1 time=s
SPL gxcesded
1284EAR A times

From this “Event Counting”
screen, you can modify the different
settings associated with the SLM
Stats screens for the SLM and Peak
detectors that you just viewed. These
are the values that if exceeded or sur-
passed, will be counted and shown.
You can set two exceedance levels for
the SPL detector, and two exceedance
levels for the Peak detector.

To change the settings for the Event (Exceedance)
Thresholds, you can either go to the SETUP menu by
pressing @) , or you can take the shortcut from where
you are now. Let’s do the shortcut.

Step 1 From within the “SLM Stats” window, press

Fk—1 Excd L1

Step 2 For this exercise, change the Peak 1 level.
Press @ until “Pk-1 Excd LvI” is high-
lighted.

Event Counting
(115>
SPL Excd Lwl 2
1208
Fk—1 Excd L1
(14085
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Step 3 Press (P to enter the “Pk-1 Excd LvI” screen.

Event Countin
Fk—1 Excd L1

dB

Step4 The @ and @ arrow keys increment
through the exceedance level numbers, while
@ and [ toggles between the three
numeric fields. Once you have selected a
desired “Pk-1 Excd LvI” value, press &.

Event Counting
115>
SPL Excd Lwl 2
128>
Fk—1 Excd Lwl
138>

The new “Pk-1 Excd LvI” value now appears in the
associated field. Press @ to exit the “Event Counting”
screen.

Ln Centiles

Ln Centiles (percentiles) represent the percent of time
that a sound pressure level exceeded a particular deci-
bel value. An L50 with a value of 47.8 means that 50%
of the measurement time, the sound pressure level was
greater than 47.8 dB.
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Modifying the Ln Settings

Step1l Press @ to move to the SLM Ln-a screen.

ISLH Lh-a

Le.zz

50.0
a47. 8

Lao.o

F
ciEH
: |

8.7

Step 2 This screen contains the Ln statistical descrip-
tors for the current measurement. Press (» to
advance to the “Ln-b Centiles” display.

L 1%

79.4%

Bl:09.43

Ln=b Centiles i

Here we see the graphic distribution of the entire Ln’s
(L1 thru L99). Use the @ and @ arrow keys move a
cursor across the graph. The value of the particular Ln
where the cursor resides is displayed.

Step 3 Press B to return to the “SLM Ln-a” display.

Li.567
Lzz.z2 -
49. 8
LEE.T
46. 1

i1S5LH Lh—a

To change the values of the six Ln settings for the SLM,
you can again go to the SETUP menu by pressing @),
or you can take the shortcut from where you are cur-
rently. Once again, take the shortcut.
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Step 1 From within the “SLM Ln” window, press @.

L
GI"E.]'I [Elll

The “Graph” settings operate the same as was shown
earlier in the “SLM Current” section. We will skip that
feature now. Press @ to highlight “Settings”.

| Ln h 3
Graph 3]

Step 2 Then press ® to enter to the “Ln” setting
screen.

Start Lewvel T

C152

Ln 1 Percent
(A@1.672

Ln 2 Percent

Within this screen you can set the Start Level” (mini-
mum dB level associated with the Percentiles graph),
and establish the values for the six Ln’s presented in
the “SLM Ln-a” table.

2/19/98
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Step 3 For this example, let’s modify the “Ln 3 Per-
cent” field. Press @ to highlight “Ln 3 Per-
cent”.

Lwn ¥
{(B81.6%)>
Ln Z2 Percent|
(BE8 .33 |0

Step4 Press B to enter the “Ln 3 Percent” field.

Ln | ¥
FErTrC B =Ls &Y |

LiLn 3 Percent

[ 3. 33

(05535 ]

Step5 The @ and @ arrow keys increment
through the percentage numbers, while @
and (® toggles between the different
numeric fields.

Ln | ¥

I T i 5
LiLn_ 3 FPercent
Er-rN-o

55,33 ]

Step 6 Once you have selected a desired “Ln 3”
value, press @.

Lwn ¥
{B81.6%7)>
Ln £ Percent||

{BE8 .33 |0
Ln 3 Percent
(848 .0808)
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Exposure

Step 7 The new “Ln 3” value now appears in the
associated field. Press @ to exit the “Ln”
screen.

Craph. o

Eettlngﬁ H]

Step 8 Press @ again to return to the “SLM Ln” dis-
play window.

This screen shows the Dose and Pro-
jected Dose. The feature is used pri-
marily when surveying workplace
noise exposure.

Here we see the dose expressed in SE
(Sound Exposure) in units of Pa?H.

Step1l Press @ to move to the SLM Exposure-a
screen.

ISLH Exposzure—a

Dose: 54.7 %
Froj. Dose: >99999%

Lex 24.7 dEA
4B SEL 21.2 dBA
BEEE: 35, 1

Step 2 Press (® to advance to the “SLM Exposure-
b display.

ISLH Exposure-h

SE: >99939 Pﬂg“

Lex 54.1 dER
e SEL21.2 dBA
BiE9:31.9
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This screen displays a C minus A
measurement that is often used for
the evaluation of hearing protection.
This is a simultaneous measurement
and subtraction of the A-weighted
Leq from the C-weighted L.

Step 3 Press P to go to the “SLM Exposure-c” dis-
play.

éEL" E}{PDEL-IF‘E- c X
Minus A

Leg o3.2 dB C
53.9 dB A
=@. 7dE C-A

Step4 Press B to return to the “SLM Exposure-a”
display.

iIS5LH Exposure—a o ¥

Dose: 5.7 ¥
Proj. Dose: >999997%

Lex 54.7 dEA
Z4E SEL 21.2 dBR
BiEE: 35, 1

Modifying the Exposure Settings

Within the “Exposure” setting
menu, you can change the different
parameters associated with noise
exposure or noise dose measure-
ments. These include the Overall
Exchange Rate, Overall Threshold
Level, Overall Criterion Level, and
the Criterion Time.

To change the Exposure or dose parameters, you can
choose to go to the SETUP menu by pressing @), or
you can take the shortcut from where you are cur-
rently. Once again, take the shortcut.

Step 1 From within the “SLM Exposure” window,
press Q.

Owll Exc:ha.nge
2dE1

Owll ThrEEhuld
(@862
Ovll Criterion
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Step 2 For sake of exercise, let’s change the exchange
rate. Use @ or @ to highlight “Ovll

Exchange”.

Exposure
Ovll Exchange
CL3dE1
Ovll Threshold

CA8E)>
Ovll Criterion

Step 3 Press (P to enter the “Ovll Exchange” win-

Step 4

dow.

The following warning will appear letting
you know that a measurement reset is
required if the exchange rate is going to be

altered.

e i e e e

7l Harning

OverAall Reset
oFequired*
Reset”

B [Cance |

Step 5 Press @ to accept the reset. The “Ovll
Exchange” window will then be displayed.

1 Exchange

LFY L L rd A WA ALFIR

2/19/98
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Overall SLM

Step6 Use @ or @ to highlight “5dB”.

Ovll Exchange
CSdEBE1
Ovill Threshold
{BBA>»
Owvll Criterion

Step 8 This selection now appears in the “Exposure

window. Press @ to return to the “SLM

Exposure” screen.

In this display, you will see a graphic
time history of the overall measured
sound pressure, along with a “real-
time” digital numeric readout of the
sound pressure level. The associated
setup parameters (detector rate and
weighting), and run time are also
shown. It should be noted that
“Overall” is different from “Cur-
rent”. Recall that “Current” shows
only the data since the last RESET
®. “Overall” is unaffected by a
RESET and is the accumulated data
from the original start of the mea-
surement.

Step1l Press @ to move to the “SLM Overall.

ISLH OwerAll-a X

52.0%
Slow SFL
BZ2:29.96
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This screen lists the date and time
when the overall measurement
began, along with the current date
and time if the measurement is run-
ning (stop date and time if it is not
running), and the elapsed run time.

The “SLM Overall-c” screen lists
the Lmax and Lmin values, and the
date and time when they occurred for
the overall measurement.

The “SLM Overall-d” screen lists
the A, C, and Flat weighted Peak
values along with the date and time
when they occurred for the overall
measurement.

Here we see the TWA and SEL val-
ues, with the total run time for the
overall measurement.

iISLH QwerAll-b )
Began

19Janl998 16
to 19Janl1993 16
Elapzsed E%? Tim?=

ISLHM QuwerAll-c X
Maximums: 83.
19Janl199:8 1

Minimums: 35,
19Jan1993 1

f$SLHM OuerAll-d ]j(t
eda

119. 3dEF

19Jan1992 1664140
117.64d
19Jan1992 1684140
118. 54
19Jan1995 16:684:48

ISLHM QuwerAll-= X
TWA LOsHA 322.4 4eA

S SEL FB. 1 dBRA
B:809:25.4

Step2 Press B to see the “SLM overall-b” screen.

Step 3 Press (B to see the “SLM Overall-c” screen.

Step 4 Press B to see the “SLM Overall-d” screen.

Step5 Press P to see the “SLM Overall-e” screen.

2/19/98 Log - Logging Sound Level Meter (Option 01)
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Step 6 Press P to return to the “SLM Overall-a”
screen.

ISLH QuerAll-a X

52.0% »

G-

Slow SPL B
BZ2:29.96

4o

Modifying the Overall SLM Settings

Changing the “Overall SLM” settings is identical to
changing the “Current SLM” settings. This is because
the Current and Overall SLM settings cannot be differ-
ent. Since this was already covered in the Current SLM
write up, please refer back to that section.

Step 1 Press VIEW @ to return to the View window.

Setup o

Edit Settings:
SLHM&RTA 5SSAax
*SLHM&RTA S5SA H

P Lnin LOG

You can see that we have already visited a number of
the Logging “Views” including “Current SLM”,
“Overall SLM”, “Exposure”, “Ln Centiles”, and
“Stats”. We accessed these by toggling the @ and @
arrow keys while we were in the measurement display
(recall that we started with “SLM Current”). Let’s look
at the rest of them now.
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Run Log

The Run Log provides a record for
each 824 measurement run and stop.
In other words, it keeps a record of
every time the RUN/STOP key &
has been pressed since the last Over-
all RESET. It logs the date and time
of the RUN/STOP key press.

This menu allows you to move to dif-
ferent places within the Run Log.
The choices are “Beginning”, “End-
ing”, and “Find”. “Beginning”
moves you to the first record in the
Run Log. “Ending” moves you to
the last record, and “Find” lets you
choose a Log record to recall and dis-

play.

Step1l Press @ to highlight the “Run Log” View
selection.

Step2 Then press @ (or P ) to select “Run Log”.

Run %qg : b3

Run 1 Key
Mon 19Jan98 16i84:37

Stop 1 Key
Morn 19Jan92 16216224

Step 3 Press @ to enter the “Log” search field.

Step 4 Select @ to exit the “Log” menu.

Run Lqp ] ¥

1
Run 1 Key
Morn 19Jan9g 1&6:064:37
Stop 1 Keuy
Morn 19Jan9s 1e:16:2A@
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Step 5 Press VIEW @ to return to the View window.

Time History

Time history function is used to store Step1 Press @ to highlight the “Time History”
only the value of the Leq and, if View option.

desired, one additional user-selected
parameter such as Lpk or Lmax.
Data can be stored as fast as 32 sam-
ples per second.

Time History

Before we view the Time History function, let’s first set
it up Press @ to enter Time History

ISLH Time Historyg o

Ho Data
Auvailable

Modifying the Time History Settings

To change the Time History parameters, you can
choose to go to the SETUP menu by pressing @), or
you can take the shortcut from where you are cur-
rently.
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The choices within the “Time His-
tory” menu include: “Beginning”,
“Ending”, “Find”, “Graph”, and
“Settings”. “Beginning” moves you
to the first Time History sample of
the active measurement. “Ending”
moves you to the last Time History
sample of the active measurement.
“Find” lets you choose a Time His-
tory sample to move to within the
Time History display. The “Graph”
settings operate the same as was
shown earlier in the “SLM Current”
section. You can control the graph
level and scale of the Time History
using this feature. “Settings” is the
area where you can modify the
parameters associated with acquir-
ing the Time History measurement.

The choices here are: “Hist Enable”,
“Hist Period”, “Period Units”,
“Other Level”, and “Resolution”.
The “Hist Enable” activates or deac-
tivates the Time History measure-
ment function.

Step1 From within the “SLM Time History” win-
dow, press @.

Tinp Histoxr i

As an exercise, we will set the 824 to gather a time his-
tory of the Leq in 10 second samples. We will also set
the instrument up so that the Lmax is acquired simul-
taneously.

Step 2 Press @ to highlight “Settings”.

[Time Histoxr i

Step 3 Next, press @ (or B ) to enter the “Time His-
tory” settings menu.

Time Histor
Hist Enable jjj
C Mu]l

Hist FPeriod
(AGA>
Period Units
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Hist Enable
L Hol

Hist Feriod
{858 )>

Feriod Units

Enable” screen.

Hist Enable

Step4 Press @ or @ to highlight “Hist Enable”.

Step5 Now press @ (or B ) to enter the “Hist

Step 6 The choices are “Yes” or “No”. Use @ or @

to highlight “Yes”. Then press @ to enter

your choice.

Hist Enable
LY¥es]

Hist FPeriod
{B658>»
Feriod Units

Time Histor
Hist Enable
LYes
Hist Feriod
{58 )

Feriod Units

“Hist Period” is used to establish the duration of each
Time History sample.

Step 7 Press @ or @ to highlight “Hist Period”.
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Step 8 Press@ (or P ) to enter the “Hist Period”
screen.

Time HiEtnrII
= L

iﬂHist'Périud

Hi[i=o]

Period Units) |

The @ and @ arrow keys increment through the
Period Time values, while @ and [ toggles
between the different numeric fields.

Step 9 Let’s set the 824 to acquire 10 second time his-
tory samples. After you have entered 10 as
the desired “Hist Period”, press () to enter
this choice.

Time History

Hist Enable ||
[EEE]l
Hist FPeriod H

(A1@)>
Period Units

“Period Units” lets you select a multiplier that ulti-
mately determines the duration between the Time His-
tory samples. This setting provides a lot of flexibility in
determining the Time History sample period.

Step 10 For our lesson, we will use 1.0 second units to
establish our 10 second time history sam-
pling. Press @ or @ to highlight “Period
Units”.

"Tine History] ©

CLYec]
Hist FPeriod
(818>
Period Units

{ 1.9s)
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Step 11 Press @ (or ® ) to enter the “Period Units”
menu.

Period Units
1-32= m
¥ 1.08s

68.Hs

The selections in the “Period Units” menu are “1/32s”,
“1s”, “10s”, and “60s”.

Step 12 Now press @ or @ to highlight the 1.0s
“Period Units” choice. Then press Q) to enter
the selection.

Time Histor
CLYes]
Hist Feriod
(Bi1E)>
Feriod Units

1.8s)

“Other Level” provides the capability of logging the
Time History of one additional measurement type,
along with the Leq. The choices include “none”, “Pk-
27, “Pk-1", “Lmax”, and “Advc”. Here.

Step 13 Let’s choose Lmax as our other measurement
to be logged. Press @ or @ to highlight
“Other Level”.

Level n
CHone 1
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Step 14 Press @ (or P ) to enter the “Other Level”
screen.

Other Level

Pk—1I1I
Pk—1I
Lmax
adwc

Step 15 Use the @ or @ arrow keys to highlight
Lmax as the other level to be logged with the
Time History of the Leq. Then press @ to
enter this selection.

Time History
{B818>

Feriod Units
{60.08=7|
Othexr Lewvel i
CLmax 1

“Resolution” lets you choose the dB resolution of the
Time History. The options are “0.1 dB” or “1.0 dB”.

Step 16 Let’s set the resolution to 1.0 for this example.
Press @ or @ to highlight “Resolution”.

"Tine History

(EB.As)
Other Level

CLmax 1
Resolution I

Ca.14B1n

2/19/98
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Step 17 Press @ (or ® ) to enter the “Resolution”
menu.

Resolution M
Ca.1dB1|

Step 18 Pressthe @ or @ arrow keys to highlight
1.0 dB “Resolution” selection. Press (&) to
enter this choice.

Time Histor
{68 .8s)

Othexr Level
Lmax 1

FResolution

Ci.ad4dB1N

Step 19 Now press @ to exit the Time History “Set-
tings” menu.

Time Histor i
Begining (M|
End ing O
Find é

Graph
Settings Fm

Step 20 Next, press @ to return to the Time History
display. There is no data because the acquisi-
tion parameters have changed.

ISLH Time Historg u ]
o

Mo Data
Available
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Viewing Time History Data

On the screen you will see a graph of
the Leq versus time. The display also
lists the value of the Leq (larger digi-
tal number), and the “other level”
(in this case Lmax) in smaller digits.
The time history period where the
cursor is currently at is shown at the
top left part of the screen. The cur-
rent total number of time history
periods is shown on the right. The
graph updates when pressing any of
the arrow keys.

Step 1 Press @ to initiate the measurement.

i/ 2,ap

dE 100

RL.II'"I A mn
B0

Keug dBEH un

ISLHM Time History

¥

Step 2  After the measurement has run for a brief

duration (minute or so), press @ or » (or
@ or @ ) to cycle through the time history
periods. The cursor will move to each time
history, and the associated information spe-
cific to the period is shown.

in/

=22 . BdER
HEE

ISLHM Time History
yap.
49.0%%

= H B0
B0
4o

d

i

Step 3 Let’s disable the time history logging by

pressing () to access the Settings menu.

[Time Histor

Begining
Ending

|

O
»
]

2/19/98 Log - Logging Sound Level Meter (Option 01)

6-29



Step4 Press B to enter the Settings menu.

Hist Enable i

LYes]
Hist Feriod

{858 )>
Feriod Units

Step 5 \Verify that “Hist Enable” is highlighted, then
press B to enter this selection menu. The
following warning screen will be shown.

— — &
| Harning
Overnll Reset
I_RE-!:[I.I.i:r=|=_-||:l!'
Reset?

| EE=[Cancel]

Step 6 Press () to accept the reset.

Hist Enable

Step 7 Now let’s disable the time history logging
feature. Press @ to highlight “No”, then
press @ to accept.

Hist Enable (j
L M ]I

[n])

Hist Feriod
(818>

Feriod Units
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Intervals

Step 8 Now press @ to return to the Time History
“Settings” menu.

Time Histor i

Step 9 Press @ again to return to Time History
view.

ISLHM Time History o
o

Ho Data
Available

Step 10 Push VIEW @ to return to the View window.

Intervals is very useful when moni-
toring noise levels for extended peri-
ods of time. An environmental noise
monitoring survey would be an
example of an application using the
Intervals feature. The following
parameters are automatically stored
to memory at user defined time that
may range from one second to 99
hours, fifty nine minutes and 59 sec-
onds each: Leq, SEL, Lmax, Lmin,
Lpkl, Lpkl. Also, you may chose to
store six Ln levels, based on user-
defined percentages, with each time
interval. This permits the user to
study the statistical distribution of
the noise as a function of time.

Step 1 Within VIEW, press @ or @ to highlight
“Intervals”.

UView
Ln Centiles

Intervals

For sake of exercise, we will configure the setting so
that we are gathering data in 1 minute intervals. Let’s
also arrange to have the Ln statistics logged with our
other interval data.
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Step 2 Now, press () to enter the Interval view
window.

Interval=- o

Ho Data
Auailable

Modifying the Interval Settings

To change the Interval parameters, you can choose to
go to the SETUP menu by pressing @), or you can take
the shortcut from where you are currently.

Step1 From within the “SLM Interval” window,
press Q.

Intervals o

Beginingd
End ing O
Find =
Settings

Step 2 Press @ to highlight “Settings”.

Intervals
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The choices here are: “Intv Enable”,
“Intv Period”, “Intv Time Sync”,
“Intv Save Ln’s”, “Intv Auto Stop”,
“Intv.  Threshold, and “Intv
Exchange”. The “Intv Enable” acti-
vates or deactivates the Intv mea-
surement function.

Step 3 Next, press @ (or B ) to enter the “Interval”
settings menu.

Intervals
Intv Enable T

L HNol

Inty Period
{0100 104>
Inty Time Suync

Step4 Press @ or @ to highlight “Intv Enable”.

Intervals

Intwv Enable T
C Nol

Intv Period

(@180 80>
Intv Time Sync

Step5 Now press @ (or B ) to enter the “Intv
Enable” screen.

Intw Enable

¥ HNo

A BN LrWY A T4 ALFLL

{81 :86 88}
Intw Time Sunc

Step 6 The choices are “Yes” or “No0”. Use @ or @
to highlight “Yes”. Then press @ to enter
your choice.

Intervals

Intwv Enable i
LYecl

Intv Period

{0100 104>
Inty Time Suync
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Step 7 “Intv Period” is used to establish the duration
of each Interval sample. Press @ or @ to
highlight “Intv Period”.

Intervals
Intv Enable

Intyv Period
{81 1008 80 )

Inty Time Sunc

Step 8 Press@ (or ® ) to enter the “Intv Period”
screen.

Intervals
Intv Period

B1iH-T"H"I"]

hhimmiss

The @ and @ arrow keys increment through the
Interval time values, while @ and [ toggles
between the different numeric fields (hh:mm:ss).

Step 9 Now enter our one minute interval choice by
selecting “00:01:00”” After you have entered
this “Intv Period”, press @ to enable this
selection.

Intervals
Intv Enable ]|

Intv Period

(@A 181 c88 Y
Intwv Time S5

6-34 System 824 Training Manual 2/19/98



“Intv Time Sync” enables or disables
the capability of synchronizing the
measurement interval with the 824’s
built-in clock. An example would be
if you wanted to have an interval
stored every hour, on the hour. The
synchronization time is dependent
on the Interval Period selected.

The “Intv Save Ln’s” enables or dis-
ables the storage of Ln statistics with
each Interval. It uses the Ln values
that are established in the SLM set-
tings of the 824.

Step 13 P

Step 10 Press @ or @ to highlight “Intv Time

Synch”.

Intervals 1
[TEE]I
Intv Period i

(B8 -81 8@ )
Intw Time Sync
{Yes

Step 11 Now press @ (or ® ) to enter the “Intv Time

Sync” screen.

Intv Time S5 ncn
¢ [=]

" EFEF m'EF L =mEFELFS

Step 12 The choices are “Yes” or “No”. For this lesson,
we will choose “No”. Use @ or @ to high-
light “No”, then push @ to enter this choice.

Intervals
CLYecd
Intv Period
(OB 681 83 )

ress @ or @ to highlight “Intv Save Ln’s”.

Intervals

(BB 81 8@
Intv Time Suncl|
{ Ho»
Intv Save ILn's

{Yec
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“Intv Auto Stop” enables or disables
the feature of having the 824 stop
after each Interval is complete. The
next Interval will then begin only
when the RUN/STOP key & is
pushed.

Step 14 Now press @ (or ® ) to enter the “Intv Save

Ln’s” screen.

Intv Save Ln's
{Yes)

Step 15 The options are “Yes” or “No”. Use @ or @
to highlight “Yes”. Then press ) to enter this

choice.

Intervals ?
(BE 181 88y
Intv Time Sunci|

o} |0
Intw EauE{Ln’sl

Yesd

Step 16 Press @ or @ to highlight “Intv Auto
Stop™.

Intervals
{ Ho)
Intv Save Ln's
{Yesi|]|
Intv Auto Stop

L Hol

Step 17 Now press @ (or (® ) to enter the “Intv
Stop’ screen.

Intv Auto S5to

Yes
Intv Auto Etupi
C Hol

Auto
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“Interval Threshold” lets you select
a threshold or level for calculating an
Interval TWA (Time Weighted Aver-
age). Only sound pressure levels
above the threshold will used in the
TWA computation.

The choices are “Yes” or “No”. Use @ or @ to high-
light your “No”.

Step 18 Then press @ to enter this choice.

Intervals 1

{ Ho»

Intv Save Ln's
{Yeosi|
Intv Auto Stopp

L Hol

Press @ or @ to highlight “Interval Threshold”.

Intervals 1

Intv Thresholdg
(eea> &

Step 19 Press @ (or B ) to enter the “Interval
Threshold” menu.

Intervals
Intwv Thireschold

The @ and @ arrow keys increment through the
Interval Threshold values, while @ and ® toggles
between the different numeric fields. For now, let’s
enter a threshold of “000”After you have chosen this
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“Interval Exchange” is used to select
the exchange rate used for calculat-
ing an Interval TWA (Time
Weighted Average). The choices are
“3dB”, “4dB”, “5dB”, and “6dB”.

“Interval Threshold”, press @) to enter the selection.

ISLH Time Historg u ]
o

Ho Data
Auailable

Step 20 Press @ or @ to highlight “Interval
Exchange”.

Intervals ?

C Hol

Intv Threshold
{B8aE >

Intv Exchange |
C3dEBE1

Step 21 Press @ (or B ) to enter the “Interval
Exchange” menu.

v Exchange

Step 22 The @ and @ arrow keys increment
through the exchange rate choices. Let’s use a
3 dB exchange rate for now. Once you have
highlighted this preference, press @.

Intervals
L Hol
Intv Threshold
{883 >

6-38

System 824 Training Manual 2/19/98



Viewing Interval Data

Step 23 Press @ to return to the “Interval” settings
menu.

Intervals

Step 24 Press @ again to enter the “Interval” mea-
surement screen.

Interval= o

Ho Data
Available

This is the Interval-a screen. It
shows the Leq and SEL for the first
interval, along with the date and
time of the interval. The bottom of
the screen shows the duration of the
interval (in this case 1 minute). The
“1/” at the top of the display indi-
cates the interval being displayed.

Step 1 Press RUN/STOP @ to initiate the measure-
ment. After the first interval is complete (60
seconds), a display similar to the following
will be shown.

Interval—a y :
25Janl99s 13:54:28

Lex S3.6&dEA
SEL 73.3dBA

Duration: Bl:@E. 00

2/19/98 Log - Logging Sound Level Meter (Option 01) 6-39



Here we see the Lmax and Lmin for
the first interval.

This display shows the Lpeakl and
Lpeak2 for the first interval.

This screen summarizes the number
of times that the SPL and Peak
thresholds were exceeded during the
interval, along with the number of
overloads that occurred.

Here we see the six Ln statistical
descriptors for the first interval.

In this case, it is the 15t interval. Press ® to

advance to the “Interval-b” screen.

Interval=hb y -'i'IE
25Janl99s 13:54:28

Lmax 6&3.JddEA
Lmin 49.5dEA

Duration: B1l:606.66

Step 3 Press B toadvance to the “Interval-c”

screen.

Interval=c y 2
23Janl99s 13:54:28

Lpeak-1 88.8dEF
Lepeak-II 89.3dBR

Duration: B1l:606.66

Step4 Press B toadvance to the “Interval-d”

screen.
Interval=d i
i/ 15
SPL > 115 Btimes

Peak-1 > 148 BLtimes
Peak-II> 148 Btimes

Overloaded BLimes

Step5 Press B toadvance to the “Interval-e”

screen.
Interval=e

i/ 15

Li.67 Le.zz
&2. 1 57.7

Lz3.z 50.0
o5c5. 1 55. 4

LEE.7 ]
- 49. 3
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In the upper right part of the display Step 6 Press (® to return to the “Interval-a” screen.
(to the right of 1/) you can see the
number of one minute intervals that
have occurred since the measure- Interval=a

1/ 17
ment was initiated. 25Janl99s 13:54:28

Lex S3.6&dEA
SEL 73.3dBA

Duration: Bl:@E. 00

Step 7 You can view the other interval data by press-
ing @.

Interval=a y &
23Janl993 13:355: 28

Lex S6.<ddEA
SEL  7a.ZdBEA

Duration: B1:88.684

Notice that a new interval number appears at the top
of the screen (2/). You can view all of the interval data
by pressing @ to advance through each time interval,
and @ or P to view the data associated with each
interval. When you are finished examining the data,
press VIEW @ to get back to the View menu.

Exceedance History

Step1 Press @ to highlight “Excd History”.

View ¥

Stats O
Run Log a
Time Historu DI
Intervals O
Excd Historu E.

The Exceedance History is useful feature that, when
enabled, will trigger the 824 when the sound level goes
above a predetermined threshold (set by the user). The
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Model 824 records the time, date, duration, and a time
history of the sound with each exceedance.

Step 2 Press () to enter the “Excd History” View
screen

Excd- X

Function
Hot. Enabled

Modifying the Exceedance History Settings

The choices within the “View Excd”
menu include: “Time History”,
“Beginning”, “Ending”, “Find”,
and “Settings”. “Time History” lets
you view Time History graphs
(event vs. time) of the exceedance
events. “Beginning” moves you to
the first Exceedance record of the
active  measurement.  “Ending”
moves you to the last Exceedance
record of the active measurement.
“Find” lets you choose an Exceed-
ance record to move to within the
active measurement “Settings” is
the area where you can modify the
parameters associated with acquir-
ing the Exceedance records.

To change the Exceedance History parameters, you can
choose to go to the SETUP menu by pressing @), or
you can take the shortcut from where you are cur-
rently.

Step 1 From within the “Excd ” window, press @.

View Excd
Time HistoryOjl
Begining O
End ing a
Find O
Settings .

Step 2 Press @ to highlight “Settings”

View Excd
Time Historul
Begining O
End ing E

Find
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This menu lets you to set an exceed-
ance threshold level. When the 824
measures a level that surpasses the
established threshold level, it will log
the exceedance history. Included
with the exceedance history is Leq,
SEL, Lmax, Peak, a graph of the Leq
during the event, and the time, date,
and duration of the exceedance. The
824 can trigger off of an SPL (rms)
level or a Peak level. A common set-
ting is to establish the “SPL Excd
Lvl 1 parameter to act as the trigger
level. We will do that in this exercise,
setting the value to 85 dB.

Step 3 Pressthe ( to enter the “Excd Settings”
menu.

Excd Settings

Excd Enable
L Hol
Min Duration
{86

Step4 Pressthe @ or @ to highlight the “Trigger-
ing”, then press the @.

Event Counting
SPL Excd L1 1W

115>
SPL Excd Lwl 2

(128>
Flk—1 Excd L1

Step5 Press @ or @ to highlight “SPL Excd LvI 1”
and the press ) to enter the “SPL Excd Lvl 1”
field.

[1 2]
dB

The @ and @ arrow keys increment through the
SPL exceedance level values, while @ and ® tog-
gles between the different numeric fields.
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“Hysteresis™ is used to establish the
end of an exceedance event. It is the
value, in dB, that must drop below
the exceedance level to signify the
end of the event. For example, if we
consider our established “SPL Excd
Lvl 17, a hysteresis value of 5 would
mean that during an exceedance
event, if the SPL level drops below
80 dB (SPL Excd Lvl 1 minus Hys-
teresis), the 824 will stop gathering
data, and re-arm its trigger for the
next exceedance event.

Step 6 Let’s enter a level of “085 dB”. After you have
chosen this “SPL Excd Lvl 17, press @) to
enter the selection.

[u]

Event Counting

S5PL Excd Lwl l'i
L1206 H

Fk—1 Excd L1

You can set the other three exceedance level parame-
ters (SPL Excd Lvl 2, Pk-1 Excd Lvl, and Pk-2 Excd Lvl)
in the same fashion. For this exercise, we will ignore
them.

Event Count ing
SPL Excd L1 2.

L1206

1285
Pk—1 Excd Lwl w
Pk—2 Excd Lwl

Step 7 Press @ to highlight “Hysteresis”.

Event Countin
Fk—1 Excd Lwl
128>
Pk—2Z2 Excd Lwl
148>

Step 8 Let’s set the “Hysteresis” to 5. Press [ to
enter the “Hysteresis” window.

LA
251

Huysteresis (i)l
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Step 9 Use @ to increment the hysteresis value to 5
dB, then press @ to enter this choice.

Event Cuuntinqﬂ

Plk—1 Excd Lwl
(128>
Pl—Z Excd Lwl
148

Step 10 Press the @ to return to the “Excd Settings”
menu. Press @ or @ to highlight “Excd
Enable”.

Excd Enable
CYes1

Min Duration
{BBZY

Step 11 “Excd Enable” activates or deactivates the
exceedance gathering feature. Let’s go ahead
and enable it. Press @ to enter this screen.

Excd Enable 5”
Mo 1 >

Step 12 Use @ or @ to highlight “Yes”. Then press
@ to activate this selection.
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This menu item defines the mini-
mum time period that the SPL level
must be above the established thresh-
old level before it will register it as
an exceedance. With the “Excd
Threshold” set to 85dB and if we
establish a “Min Duration” of 5 sec-
onds, the 824 will log an exceedance,
in the exceedance history, when the
SPL level is above 85dB for a time
period at least 5 seconds long. Let’s
set the “Min Duration” to 5 sec-
onds.

Step 13 Now, press @ or @ to highlight “Min
Duration”.

Excd Settings—y
Tr igger ing }m
Excd Enable i

CYes
Duration
(Aaz>

Min

Step 14 Press () to enter the “Min Duration” menu.

Hin Duration

[ H

sec
Excd 1ime—Hist

Step 15 Use @ and @ increment through “Min
Duration” values. @ and (® toggles
between the three numeric fields. Enter 5 sec-
onds. Then press @.

Excd Settings
Ty igger ing }m
Excd Enable i

CYesd
Min Duration

CEau5Sy

Step 16 Next, push @ and @ to highlight “Excd
Time-Hist”. With this menu item set to “Yes”,
a time history of the event will be saved when
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an exceedance event occurs. Let’s set this field
to “Yes”.

Step 17 Press @ to enter the “Excd Time-Hist” menu.

Excd Ti|'|'u=_--—Hi1_=.'l:.|:|
¢ [=]

Excd Tinelﬁ?;£H
CLYes1

Step 18 Now use @ or @ to select “Yes”. Then
press (¥ to accept this choice.

MCExcd Settinas
CLYes1

Min Duration
CEAEAS)

Excd Time—Hist

CYecs]d

Step 19 Press @ and @ to highlight “T.H. Period”.
This menu establishes the sampling rate for
time history data acquired during the exceed-
ance event.

2/19/98
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The number entered in this field will
be divided by 32. For example, a
value of 1 will result in a time his-
tory sample period of 1/32 seconds
(32 times per second). A value of 32
will yield a 1 second sample period.

Here you can choose between
“Level” or “Passby” as a means of
triggering the exceedance data cap-
ture. Passbhy incorporates the 10 dB
down-points in the exceedance
acquisition. (see user manual for
details on Passhy).

Step 20 Press ) to enter the “T.H. Period” menu.

Excd Settings -

T-H. FPeriod

1732 sec

Step 21 For this exercise, let’s enter 32 to establish a 1
second period. Use @ and @ increment
through “T.H. Period” values. @ and
toggles between the three numeric fields.
Enter 32. Then press @.

Excd Settings

{885
Excd Time—Hist
CY¥es1

Step 22 Press @ and @ to highlight “Excd Trig-

ger”.

u]

Excd Settings
CLYecs]

T-H. Period
{EEE)I

Excd Tiriggexr H
[Level 1N

Step 23 Press @ to enter the Excd Trigger menu.

Excd Trigger ||

#Level ut]

[ PassBy ||| I
-

T WP Fals

Excd Tr igger
Level 1
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Step 24 For this example, we will use “Level”. Press
@ or @ to highlight “Level”. Then, press
@ to activate this selection.

Excd Settin n

CLYes1

T-H. FPeriod
(BEE}I
Excd Trigger H
[Level 1N

=

Step 25 Now, press @ or @ to highlight “Excd
Time”.

Excd Settings 5

{(B3Z>»

Excd Trigger
Level 1
Excd Time |
CStartl

Step 26 Then, press @ to enter the “Excd Time”
menu.

o
Excd Time M
CStart] 1]

Here you establish the criteria for ~ Step 27 Use @ or @ to highlight “Start”. Then,
where the exceedance time occurred. press ( to activate this selection.

“Start” logs the exceedance time as
the moment when the sound level
crossed the predefined exceedance
level. “Max” logs the exceedance
time at the point where the maxi-

MExcd Settinogs 5

(BA3ZE)
Excd Trigger
i Level 1
mum sound level occurs during the Excd Time

|
exceedance event. CStartln
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Step 28 Press @ to exit the “Excd History” menu.

Excd Settings

Step 29 Now press @ again to return to Excd view.

Excd- o

Mo Data
Available

Viewing Exceedance History Data

Here you will note a number of
things. First, the Leq and SEL of the
event are shown. In addition, the
date and time of when the exceedance
event started are logged. At the bot-
tom of the screen, the total duration
of the exceedance event is listed.

Step 1 Press @ to start the measurement. Make
enough noise (whistle or whatever) to exceed
the 85 dB exceedance trigger level and initiate
the gathering of exceedance history data. You
should see a “Excd-a” screen similar to the
one below.

Excd-a y )
25Janl199s 18:85: 20

Lex 89.9dEA
SEL 98.6&dBA

Duration: BE:IET.SH
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This display shows the Peak 1, Peak
2, and Lmax values for the exceed-
ance event.

Again, the Leq and SEL of the event,
and the time and date of the start are
logged. Notice the “2/” label at the
top of the screen. This indicates that
you are looking at the 29 exceedance
event.

Step 2

Step 3

Step 4

Step 5

Press [ to advance to the “Excd-b” screen.

Press @ or [® to return to the “Excd-a”

Excd-b

25Janl1922 1 81;85 : 21El
Feak-I 183. 1d4BF
Feak-I1 181.8d4dER
Max  92. 3dEA

screen.

Excd-a y )
23Janl993 13:85: 248

Lex 89.9dEA
SEL 98.6dEA

Durations BE:E7.354

Go ahead and create another noise event to
initiate one more exceedance event. Once that
is done, press @ to view the data from this
event.

o

Excd-a i
2/ 2
23Janl993 13:19:14

Lex 99.3dEA
SEL 188. 1 dEA

Durations BE:ETF.36

ress ) to enter the “View Excd” menu.

View Excd ¥
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The larger number on the screen is
the sound pressure level at the loca-
tion of the cursor. Just below is a
value that indicates the number of
samples (with respect to the cursor
location) before (or after) the maxi-
mum SPL of the event.

Step 6 Now, verify that “Time History” is high-

lighted, then press @.

Excd-TH §
+ a2/ ERE]

E 4B 100
H 8o
—9.88 &0
+ 17/ ay b

Step 7 Here we see a graph of the time history event.
Press ® to advance the cursor across the

graph.

Excd-TH
+

5 .:||:|E ioo

Step 8

Begining O

End ing O
i a
]

The other choices within the “View Excd” menu
include: “Beginning”, “Ending”, “Find”, and “Graph”.
“Beginning” moves you to the first exceedance time
history record. “Ending” moves you to the last exceed-
ance time history record. “Find” lets you select the
number of the exceedance time history record that you
wish to advance to. The “Graph” settings operate the
same as was shown earlier in the “SLM Current” sec-
tion. You can control the graph level and scale of the
Exceedance Time History using this feature. “Settings”
is the area where you can modify the parameters asso-
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Spectra Intervals

ciated with acquiring the Exceedance Time History
measurement.

The Log option also adds the very useful feature of
automatically collecting 1/3 or 1/1 octave band spec-
tra over time to the Simple Sound Analyzer (SSA). You
can capture and store data as fast as 1 spectrum per
second. Let’s activate this feature now.

Step 1 Press @) to enter the setup menu.

*Logging
F SLM&RTA S5S5A
FHiRange ISH

Step 2 To select the SSA measurement setup, press
@ to highlight “SLM&RTA SSA”

0
F SLMHE&RTEA S5A
r HiRange ISH

Step 3 Press @ to select this setup

SLM+RETH a

SPL SIE‘:I'I.élizu_

—— — A 100-
B0-
LE“:[ BO-

@@z aa, aa
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Step 4 Next, press the @ to enter the Interval setup
menu area.

iy Data
RTA Liwve
ETﬁ Leqg

TA Max

Step 5 Next, press @ to highlight “Settings”

Intervals D|
Lecg E-Ectraﬂu

Step6 P

Begining
End ing O
Find O

Step 7 Press @ to highlight “Settings.

Intecrvals o
Max»x Spectral
Begining (M|
End ing O
Find O
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Step 8 Next, press @ (or B ) to enter the “Interval”
settings menu.

Intervals
Intv Enable T

L HNol

Inty Period
{0100 104>
Inty Time Suync

Step 9 Now press @ (or ® ) to enter the “Intv
Enable” screen.

Intv Enable
V< i
| Yes

A IR v A T4 ALFLL

(@180 80>
Intv Time Sync

Step 10 The choices are “Yes” or “No”. Use @ or @
to highlight “Yes”. Then press @ to enter
your choice.

Intervals
Intv Enable T

CYes1

Intv Period
{81 :86 88}
Intw Time Sunc

Step 11 “Intv Period” is used to establish the duration
of each Interval sample. Press @ or @ to
highlight “Intv Period”.

Intervals
Intv Enable

Inty Period
{81006 683D

Inty Time Suync
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Step 12 Press @ (or B ) to enter the “Intv Period”
screen.

Intervals o
Intv Period
B1H-T"H "]

hhimm:ics

The @ and @ arrow keys increment through the
Interval time values, while @ and [ toggles
between the different numeric fields (hh:mm:ss).

Step 13 Now enter a ten second interval choice by
selecting “00:00:10".

Intervals
Intv Period

ECHTTH1t]

hhimmiss

Step 14 Press @ (or ® ) to enter the “Intv Period”
screen.

Intervals
Intv Enable |
CY¥es1
Intv Period

(8@ 188 187
Intwv Time Sunc

Step 15 The @ twice to exit Interval Settings.
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Interval- o

Mo Data
Auvailable

Viewing Spectra Intervals

After you have enabled the Interval setup parameters,
press VEIW @ to access the Simple Sound Analyzer
(SSA) View menu

ectral
Mas Specteadl]

Step 2 Press @ to activate this View selection.

Leqg o

Ho Data
Available
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Here you see the Leq (average) spec-
trum for an interval. The 824 will
continue to log spectra (every 10 sec-
onds).

As you increment through the
logged spectra, you can see the inter-
val number above the large Leq value
at the top, left part of the screen. Use

@ or [® tomove the cursor across
the frequencies.

Step 3 Now press RUN/STOP & to begin the mea-
surement. The first Interval spectrum will
appear after 10 seconds.

L o neFekEq8 05:37:29 i

leBEH=
00:10.00

Step 4 To look at other logged spectra, press @ to
increment through the 10 second Leq’s.

L ec n9Fekq8 12:13:16 i

leBEH=

Step5 Now let’s look at the Max spectra for each
interval. Press View @ to return to the View
screen

Step 6 Press @ until you have highlighted the
“RTA MAX” selection.

| Uiew X
RTa Leq (1|
RTA HMax A3

Intervals (M|
Leqg Spectrall

Max Spectral

6-58

System 824 Training Manual 2/19/98



The Max spectra is the frequency
spectrum that contains the largest
amount of acoustic energy that
occurred during the measurement
interval. As you increment through
the logged Max spectra, you can see
the interval number at the top, left
part of the screen. Use @ or B to
move the cursor across the frequen-
cies.

Step 7 Press @ to view the Interval Max spectra

Max»< o9Ferq8 15:05:08
T 3B5

dBEYs @mg-.------

BOqy- -+ d-cvvvv--
SHEH= ‘ I
0D:10.00 i} R T |

You can see the other logged Max spectra by pressing

the @ and @ arrow keys.
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